
2000 Platform
Handheld, modular Platform 
designed for the construction, 
turn-up and maintenance of fiber 
networks

User Manual





Viavi Solutions
1-844-GO-VIAVI
www.viavisolutions.com

2000 Platform
Handheld, modular Platform designed 
for the construction, turn-up and 
maintenance of FTTx networks

User Manual

http://www.viavisolutions.com
http://www.viavisolutions.com
http://www.acterna.com




User Manual 79000000203 Rev. 005 v

Notice

Every effort was made to ensure that the information in this document was 
accurate at the time of printing. However, information is subject to change 
without notice, and Viavi reserves the right to provide an addendum to this 
document with information not available at the time that this document was 
created.

Copyright 

© Copyright 2016 Viavi, LLC. All rights reserved. Viavi, Enabling Broad-
band and Optical Innovation, and its logo are trademarks of Viavi, LLC. All 
other trademarks and registered trademarks are the property of their 
respective owners. No part of this guide may be reproduced or transmitted 
electronically or otherwise without written permission of the publisher.

Trademarks

Viavi and MTS/T-BERD 2000 are trademarks or registered trademarks of 
Viavi in the United States and/or other countries.

Microsoft, Windows, Windows CE, Windows NT, and Microsoft Internet 
Explorer are either trademarks or registered trademarks of Microsoft 
Corporation in the United States and/or other countries.

Netscape Navigator is a trademark or registered trademark of Netscape 
Communications Corporation in the United States and other countries.

Specifications, terms, and conditions are subject to change without notice. 
All trademarks and registered trademarks are the property of their respec-
tive companies.
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Ordering information

This guide is a product of Viavi's Technical Information Development 
Department, issued as part of the User Manual. The ordering number for a 
published guide is E2000M02.

WEEE Directive Compliance

Viavi has established processes in compliance with the Waste Electrical 
and Electronic Equipment (WEEE) Directive, 2002/96/EC, and the Battery 
Directive, 2006/66/EC.

This product, and the batteries used to power the product, should not be 
disposed of as unsorted municipal waste and should be collected sepa-
rately and disposed of according to your national regulations. In the Euro-
pean Union, all equipment and batteries purchased from Viavi after 2005-
08-13 can be returned for disposal at the end of its useful life. Viavi will 
ensure that all waste equipment and batteries returned are reused, recy-
cled, or disposed of in an environmentally friendly manner, and in compli-
ance with all applicable national and international waste legislation.

It is the responsibility of the equipment owner to return equipment and 
batteries to Viavi for appropriate disposal. If the equipment or battery was 
imported by a reseller whose name or logo is marked on the equipment or 
battery, then the owner should return the equipment or battery directly to 
the reseller.

Instructions for returning waste equipment and batteries to Viavi can be 
found in the Environmental section of Viavi’s web site at www.viavisolu-
tions.com. If you have questions concerning disposal of your equipment or 
batteries, contact Viavi’s WEEE Program Management team.

http://www.viavisolutions.com
http://www.viavisolutions.com
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About This Guide
The MTS/T-BERD 2000 of Viavi provides a handheld modular platform 
designed for the construction, turn-up and maintenance of fiber networks.

The topics discussed in this chapter are as follows:

• “Purpose and scope” on page xviii

• “Assumptions” on page xviii

• “Technical assistance” on page xviii

• “Conventions” on page xviii
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Purpose and scope
The purpose of this guide is to help you successfully use the MTS/T-BERD 
2000 features and capabilities. This guide includes task-based instructions 
that describe how to install, configure, use, and troubleshoot the MTS/T-
BERD 2000. 

Additionally, this guide provides a complete description of Viavi’s warranty, 
services, and repair information, including terms and conditions of the 
licensing agreement.

Assumptions
This guide is intended for novice, intermediate, and experienced users who 
want to use the MTS/T-BERD 2000 effectively and efficiently. We are 
assuming that you have basic computer and mouse/track ball experience 
and are familiar with basic telecommunication concepts and terminology.

Technical assistance 
If you require technical assistance, call 1-844-GO-VIAVI. For the latest 
TAC information, go to http://www.viavisolutions.com/en/services-and-
support/support/technical-assistance.

 Conventions
This guide uses naming conventions and symbols, as described in the 
following tables.

http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
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Table 1 Typographical conventions

Description Example

User interface actions appear in 
this typeface.

On the Status bar, click Start.

Buttons or switches that you 
press on a unit appear in this 
TYPEFACE.

Press the ON switch.

Code and output messages 
appear in this typeface.

All results okay

Text you must type exactly as 
shown appears in this type-
face.

Type: a:\set.exe in the dialog 
box 

Variables appear in this type-
face.

Type the new hostname

Book references appear in this 
typeface. 

Refer to Newton’s Telecom Dic-
tionary

A vertical bar | means “or”: only 
one option can appear in a single 
command.

platform [a|b|e]

Square brackets [ ] indicate an 
optional argument.

login [platform name]

Slanted brackets < > group 
required arguments.

<password>

Table 2 Keyboard and menu conventions 

Description Example

A plus sign +  indicates simultaneous key-
strokes.

Press Ctrl+s

A comma indicates consecutive key strokes. Press Alt+f,s
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Table 3 Symbol conventions

Table 4 Safety definitions

A slanted bracket indicates choosing a sub-
menu from menu.

On the menu bar, click 
Start > Program Files.

Table 2 Keyboard and menu conventions  (Continued)

Description Example

This symbol represents a general hazard.

This symbol represents a risk of electrical shock.

NOTE

This symbol represents a Note indicating related informa-
tion or tip.

This symbol, located on the equipment or its packag-
ing indicates that the equipment must not be disposed 
of in a land-fill site or as municipal waste, and should 
be disposed of according to your national regulations.

WARNING

Indicates a potentially hazardous situation which, if not 
avoided, could result in death or serious injury.
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CAUTION

Indicates a potentially hazardous situation which, if not 
avoided, may result in minor or moderate injury.
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Chapter 12000 Platform Overview

This chapter provides a general description of the 2000 Platform.

Topics discussed in this chapter include the following: 

• “Unpacking the instrument” on page 2

• “About the 2000 Platform” on page 2

• “Main features” on page 3

• “Hard keys and Indicators” on page 6

• “Power Supply” on page 8
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Unpacking the instrument
1 Remove the 2000 Platform and its accessories from the packing 

case.

2 Check that the module and accessories ordered are all there.

If any part is missing or damaged please contact your local Viavi agent.

The 2000 Platform is delivered as standard with:

About the 2000 Platform
The architecture of the 2000 Platform is made of one Platform, to which a 
module can be added to perform tests on fiber networks.

The modules that can be fitted to the 2000 Platform are interchangeable in 
the field and different kinds of module are usable:

• OTDR Modules

Table 1 Elements delivered on standard with the 2000 Platform

A Getting Started Manual

A Li-Polymer battery, set into the equipment and which must be 
charged before use

A mains adapter used for mains operation of the instrument and bat-
tery charging 

5 country adaptable plugs (Europe / UK / US / Australia / Japan)

A hands-free soft case for the 2000 Platform

A USB cable, to directly connect the 2000 Platform to a PC

A shoulder strap
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• PON Selective Power Meter (OLP)

• CWDM Analyzer Modules (C-OSA)

The 2000 Platform employs multi-tasking for the simultaneous perfor-
mance of several operations:

• acquisitions

• modifications of parameters

• trace analysis

• report management

It also allows to use simultaneously several functions:

• Power Meter

• Scope

• OTDR measurements...

Main features
The 2000 Platform is equipped with the following elements:

• A 5 inch TFT color touchscreen, high visibility

• RJ45 plug for Ethernet interface

• Two USB 2.0 host connectors for Microscope, USB memory stick, 
mouse, keyboard...

• One mini USB 2.0 device connector to connect the 2000 Platform to 
a PC

• An audio jack to connect a headset

• A connection socket for the mains adapter providing the 12 V power 
supply and used to charge the battery.

• LED indicators for Charge, On status and Test

• A Li-Polymer battery

• A module interchangeable in the field: OTDR, OLP, or C-OSA.

• Built-in Power Meter, VFL and/or Talkset (options)
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With the 2000 Platform, the user can:

• Open and/or transfer files to a PC via a USB memory stick, USB 
cable or Bluetooth (option)

• Generate pdf reports

• Open all user documentations included into the 2000 Platform

• Update the 2000 Platform firmware

• Remote the screen of the 2000 Platform onto a PC and issue 
commands from the keyboard of the PC

• ...

Figure 1 2000 Platform with module
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Figure 2 2000 Platform: Front view

Hard keys

Indicators

Loudspeaker

TFT 5’’ Color 
Touchscreen

Figure 3 2000 Platform: Connectors View

RJ45 USB host Power Meter VFL Mini USB 
device

AC/DC 
Input

Headset 
jack
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Hard keys and Indicators

Front panel hard keys

Figure 4 Hard keys and Indicators

Table 2 Hard keys description

Hard key Function

Main on/off switch

This button calls up the file explorer. It allows to:

• choose the storage medium: internal memory, USB key.

• manage files; with facilities for classifying them in directories 
and sub-directories.

Gives access to:

• selection of the different measurement or functions

• the settings of the instrument

• the help page

This button calls up the measurement configuration menu. This 
menu depends on the function in use.

This button allows to deselect a function or escape a menu

Starts and stops the measurement.
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The direction keys have two principal functions:

Front panel indicators
The 2000 Platform is equipped with three indicators, lit into a different color 
according to the status of the unit.

This button calls up the results page (e.g. with OTDR module: 
reflectometry trace and table of results).

Table 2 Hard keys description

Hard key Function

NOTE

All these functions, except HOME, depend on the modules 
used and the measurements made: refer to the user manu-
als of the corresponding modules of the 2000 Platform.

• on the Results page, they are used to move the 
cursors or modify the zoom factor.

• on the set-up pages, they are used to scroll 
through the menus, the central button serving to 
select or confirm the parameter chosen.

Table 3 Indicators Status

On indicator

 Blinking 
green

The instrument, though connected to an external power 
source, is switched off.

Solid green The instrument is operating, either by battery or on an 
external power supply.
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Power Supply
The 2000 Platform may operate with

• the Li-Polymer battery, already set into the equipment on delivery.

• an AC adapter/charger, via a power cable on which has been set the 
correct country adaptable plug.

Charge indicator

Solid green The instrument is connected to an external power source 
and the battery is fully charged.

Solid red The instrument is connected to an external power 
source, and the battery is on charge.

Testing indicator

Solid red At least one function is in measurement phase (for exam-
ple, the laser emission pilot for an OTDR measurement)

Table 3 Indicators Status

Figure 5 Delivered elements for 2000 Platform supplying

Interchangeable plugs

UK adaptable plug 
(installed by default)

EUROPE 
adaptable plug

US
adaptable plug

JAPAN
adaptable plug

AUSTRALIA
adaptable plug

Power supply plug
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Chapter 2Safety information

This chapter gives the main information on the safety conditions when 
using the 2000 Platform:

• “Battery and AC/DC safety information” on page 10

• “Precautions relating to optical connections” on page 11

• “Laser Safety instructions” on page 11
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Battery and AC/DC safety information
• The Li-Polymer battery is designed for maximum safety.

In particular, each cell is provided with a safety valve to prevent excessive 
internal pressure in the event of overcharging or exposure to very high 
temperatures.

• Battery supplied by Viavi incorporate protection means.

Do not use any mains adaptor or battery other than those supplied with the 
instrument, or supplied by Viavi as an option for this instrument.

If another adapter or battery is used, it may damage the 2000 Platform 
itself.
Using the 2000 Platform with a battery other than the one supplied by the 
manufacturer of the 2000 Platform may entail risks of fire or explosion. 

The battery may explode, leak or catch fire:

– if it is exposed to high temperature or fire

– if it is opened or dismantled.

Other basic safety precautions are as follows:

• Do not use AC/Adapter/Charger outdoors or in wet or damp locations

• Connect the AC/Adapter/Charger to the correct mains voltage, as 
indicated on the ratings label.

• Do not allow anything to rest on the power cord, and do not locate the 
product where people can walk on the power cord.

• Avoid using this product during an electrical storm. There may be a 
remote risk of electric chock from lightning.

• Do not use this product in the vicinity of a gas leak or in any explosive 
environment.
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• Do not attempt to service this product yourself, as opening or 
removing covers may expose you to dangerous, high voltage points 
and other hazards. Contact qualified service personnel for all service.

Precautions relating to optical connections
• The normal operating life of an optical connector is usually of the 

order of a few hundred manipulations. It is then advisable to manipu-
late the optical connections of the Platform as rarely as possible.

• The proper operation of the instrument and its accuracy of measure-
ment are dependent on the cleanliness of the environment and the 
optical connectors as well as the care taken in its manipulation.

• The optical connectors must therefore be clean and dust-free. If the 
optical connection is not being used, protect the connections of 2000 
Platform using the protective caps.

Laser Safety instructions
The provisions contained in two standards define the safety procedures to 
be observed both by users and by manufacturers when utilizing laser prod-
ucts:

• EN 60825-1: 2001 - Safety of laser products – Part 1: Classification 
of products, requirements and user guidelines. 

• FDA 21 CFR § 1040.10 - Performance standards for light-emitting 
products - Laser products.

Due to the range of possible wavelengths, power values and injection char-
acteristics of a laser beam, the risks inherent in its usage vary. The laser 
classes form groups representing different safety thresholds.

Laser classes
Standards EN 60825-1, Edition 1.2, 2001-08 and FDA21CFR§1040.10: 
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• VFL option: Class 2.

Warning labels for the laser classes 
Due to the reduced dimensions of the optical modules, it is not possible to 
attach the required warning labels to them. In line with the provisions of 
Article 5.1 of the EN 60825-1 standard, the laser class identification labels 
are shown below:

The user must take the necessary precautions concerning the optical 
output of the instrument and follow the manufacturer’s instructions.

Reference 
standard

EN 60825-1, Edition 1.2, 2001-08 FDA21CFR§1040.10

Class 1

Class 2

CLASS 1
LASER PRODUCT

LASER RADIATION
DO NOT STARE INTO BEAM
CLASS 2 LASER PRODUCT

LASER RADIATION - DO 
NOT STARE INTO BEAM 

CLASS II LASER PRODUCT

CAUTION

Measurements on optical fibers are difficult to execute 
and the precision of the results obtained depends 
largely on the precautions taken by the user.



3

User Manual 79000000203 Rev. 005 13

Chapter 3Starting up

This chapter describes the first steps to perform when using the 2000 Plat-
form.

The topics discussed in this chapter are as follows:

• “Fitting and removing a module” on page 14

• “Setting the adaptable plug to the mains adapter” on page 16

• “Charging the battery” on page 17

• “Switching the 2000 Platform on and off” on page 20

• “First start: configuring your regional settings” on page 21
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Fitting and removing a module

Fitting a module
1 Turn the instrument face down on the work surface.

2 Set the two notches on the module part (1a) into the two holes 
provided for that purpose on the Base (1b).

3 Make flush the 2 connections (2a & 2b), on module and base.

4 Once positioned, fix the module to the base screwing the 2 screws 
(3a) fixing the receptacle.

The 2000 Platform must be switched off, and if it is 
operating on the mains, its supply cable must be 
unplugged.



Chapter 3 Starting up
Fitting and removing a module

User Manual 79000000203 Rev. 005 15

Removing a module
1 Unscrew the two captive fixing screws of the module completely (up 

to the stop).

2 Remove the two slots of the module from their housing onto the 
base.

3 Carefully remove the module out of its slot.

Figure 6 Fixing the module to the base

Captive screws fixing the module

1b
1

2a

2b

2000 Platform with module installed

2000 Platform without module

1
1a

3a
3a



Chapter 3 Starting up
Setting the adaptable plug to the mains adapter

16 User Manual 79000000203 Rev. 005

Setting the adaptable plug to the mains 
adapter

The 2000 Platform is supplied as standard with a mains adapter and 5 
country adaptable plugs (Europe / UK / US / Australia/Japan).

To set the correct plug to the mains adapter:

1 Make flush the connector onto the mains adapter with the adaptable 
plug slots.

2 Push the adaptable plug until it stops.

Figure 7 Setting the adaptable plug onto the mains adapter

1

2 3
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Charging the battery

Connecting the mains adapter
1 Set the appropriate adaptable plug to the power supply cable, 

according to your country (see page 16).

2 At the right side of the 2000 Platform, lift up the power supply socket 
protector and plug in the mains adapter. 

3 Connect the adapter to the mains. 

The On indicator lamp starts to blink in green.

First use of the battery
At the delivery, the battery is already set into the Platform, but its charge 
level is not «recognized» by the equipment. 

If the adapter plug is not correctly set onto the mains 
adapter, the connector may be damaged.

NOTE

The AC/DC adapter/chargers from the 4000 platform (refer-
enced E40PWxx) can also be used to connect the 2000 
Platform to mains 

Use only the mains adapter supplied with the 2000 
Platform. The adapter for some other electronic device 
may appear to be identical, but entails a risk of damage 
to the 2000 Platform.
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The icon  is displayed on the upper banner of the screen.

To get a valid indication of the battery, and be able to use correctly the Plat-
form:

1 Charge fully the battery

2 Once fully charged, discharge the battery by keeping the Platform 
switched on, but not plugged to mains.

3 The battery can then be charged, and the Platform used simultane-
ously.

Charging the battery
On connection to the mains:

• if the user does not press ON, the battery will start the charge. In this 
case, the Charge indicator will be lit in red. 

• when the user presses the ON key, the instrument starts up and the 
battery will charge during use (Charge indicator in solid red).

Once the battery is fully charged, the Charge indicator is lit in solid green.

When the Charge indicator is blinking red, this mean the power supply is 
not compatible with the battery used. Charge is disabled.

Battery charging time
If the battery is completely discharged, the time taken to recharge is:

• approximately 3.5 hours, if the apparatus is not in use (Charge indi-
cator solid red)

It is essential to wait until charging is complete to 
ensure maximum independent operating time, which 
may otherwise be considerably reduced.
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• about 9.5 hours if the instrument is used during charging (On indi-
cator lit in fix green, Charge indicator lit in solid red).

Battery charge level display
When the battery is installed in the instrument, a battery icon is displayed 
in the top right-hand corner of the screen. Example: .

• When the level becomes too low, the instrument emits a beep ton 
inform the user until it switches off automatically after saving the 
current configuration and measurement.

Table 4 Battery icons

The battery capacity is superior to 75%

The battery capacity is set between 50% and 75%

The battery capacity is set between 25% and 50%

The battery capacity is inferior to 25%

The battery capacity is unknown. Perform a full charge/dis-
charge of the battery to get back to a valid indication.
This icon may appear if battery is changed or if the battery 
auto discharges at a very low level (example: if a Platform 
switches off as battery is empty, and the charge is not done 
during several months (= auto discharge)).
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Switching the 2000 Platform on and off

Switching on the 2000 Platform
1 Press the ON/OFF key.

If the Platform is powered to mains, the battery will charge.

The On indicator pass from blinking to solid green. 

The Viavi logo appears on the screen briefly, then an auto test is 
carried out.

The equipment is ready to be used once all the applications are 
installed.

Switching off the 2000 Platform
While the 2000 Platform is operating, press the ON/OFF button to switch it 
off.

NOTE

It is possible to switch over from battery to mains operation, 
or vice versa, without loss of data.

The module cannot be swapped when the unit is ON or 
AC powered

In the event of an unexpected mains power cut, if there 
is no battery, the current results and configuration will 
not be saved. Next time the instrument is switched on, 
it will return to its initial configuration.
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Resetting the 2000 Platform
If the 2000 Platform freezes, prolonged pressure (about 4 s.) on the ON/OFF 
key will reset the instrument.

First start: configuring your regional 
settings

Once the 2000 Platform is switched on, the first screen displayed allows to 
configure the regional settings.

Those settings will be kept in memory and automatically applied on the 
instrument each time it is restarted.

NOTE

When the instrument is switched off using the ON/OFF but-
ton, current results and configuration are saved. Next time 
the ON/OFF key is pressed, they are recalled.
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1 Click on Language and select the language to be used for the equip-
ment.

2 Click on Date and enter the current date, using the numeric keypad 
displayed using the menu key Edit Number.

3 Click on Time and enter the current time, using the numeric keypad 
displayed using the menu key Edit Number.

The date and time are displayed on the upper right side of the 
screen.

4 Click on Date Time Format and configure the following parameters:
– Date format: select one of the option dd/mm/yy or mm/dd/yy.

– Time format: select one of the option 24 hour clock or 12 hour clock.

5 Click on Net Time parameter to configure the date and time 
according to a network.

Dynamic Mode: the time is synchronized according to the local 
network.

The two lines Server Name are displayed but cannot be modified.

Static Mode: in this case, the time is synchronized to the network 
server which is defined in the two following parameters.

Figure 8 Regional Settings
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On the parameter Address Type, select if the address of the 
server which will be used for synchronization is entered via its IP 
Address or via the Server Name..

If IP Address is selected, enter one or two server addresses in 
the following parameters. During synchronization, the first 
address will always be used, but if a fail occurs, the second one 
will be used.

If Server Name is selected, enter the name of the server, and if 
necessary a name for second server. During synchronization, 
the first server name will always be used, but if a fail occurs, the 
second one will be used.

During synchronization the icon  displays on the upper banner between 
the date and time.

1 Once all parameters have been defined, press Exit menu key to 
return to System Settings page.
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Chapter 4Configuring the 2000 

Platform 

This chapter describes the operations for configuring the instrument.

The topics discussed in this chapter are as follows:

• “Displaying the System Settings screen” on page 26

• “Defining the screen parameters of the 2000 Platform” on page 27

• “Defining the Audio parameters of the 2000 Platform” on page 28

• “Defining the Automatic shutdown of the 2000 Platform” on page 29
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Displaying the System Settings screen
To display the System Settings screen, you must:

1 Press the HOME hard key to reach the Home page.

2 Activate the Settings icon to open the System Settings 
screen.

Figure 9 Home page

Figure 10 System Settings page



Chapter 4 Configuring the 2000 Platform
Defining the screen parameters of the 2000 Platform

User Manual 79000000203 Rev. 005 27

Defining the screen parameters of the 2000 
Platform

In the System Settings page, the following parameters can be defined:

Backlight
1 Click on Backlight 

2 Define the backlight level of the screen, using the left and right direc-
tion keys, or clicking on Edit Number softkey and using the keypad 
displayed.

– Min backlight level: -5

– Max backlight level: +5

Contrast
1 Click on Contrast

2 Select the type of environment into which the instrument is used:

– Indoor: to be selected when the instrument is used inside (see 
Figure 10 on page 26)

– Outdoor: to be selected in order to optimize the readability of 
the screen for an outside use.

NOTE

If you are in the Regional Settings page, and you press 
Exit, then the System Settings page automatically dis-
plays.

If the 2000 Platform is operating on battery, it is advis-
able to choose a minimum lighting level, acceptable for 
the user, to keep endurance as long as possible.
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Screen Saver
Click on Screen Save if you wish to activate a screen saver to the equip-
ment, to extend the life of the battery, in case the 2000 Platform is not used 
for some time.

Instead of the normal screen, a small animated picture of the 2000 Platform 
is displayed on the blackened screen. 

To configure the screen saver:

1 Click on Delay and select the time of inactivity before the 
screen saver starts: 60s, 3 min, 5 min.

The parameter No deactivates the screen saver function.

Defining the Audio parameters of the 2000 
Platform

In the Audio box of the System Settings screen, you can configure the 
audio parameters according you are using a headset with the 2000 Plat-
form.

Figure 11 Example of outdoor contrast
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1 Adjust the volume on the line Hands-free Volume using the left and 
right direction keys, or the Numeric keypad (displayed with the 
softkey Edit Number)

– Min volume for Hands-free function: 0

– Max volume for Hands-free function: 100

2 If a headset is used, adjust the volume on the line Headset Volume, 
using the left and right direction keys, or the Numeric keypad 
(displayed with the softkey Edit Number):

– Min volume for Headset function: 0

– Max volume for Headset function: 100

Defining the Automatic shutdown of the 
2000 Platform

The automatic shutdown function switches off the 2000 Platform automat-
ically if no operation has been performed and no key actuated for a period 
selected from this menu. Work in progress is automatically saved.

1 In the Utility box, click on Auto off parameter.

2 Choose a time after which the 2000 Platform will be switched off 
automatically, if no action has been done for that period: 5, 10 or 30 
minutes.

Select No if the 2000 Platform must not be switched off, even if there is 
inactivity on the equipment.

The function for automatically switching off the 2000 Plat-
form is available only on battery operation, to save the bat-
tery.
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Chapter 5Power meter, VFL (Visual Fault 

Locator) & Talkset

A variety of built-in optical options are available when ordering. See refer-
ences in Chapter 15 “Options and accessories”, for details.

The topics discussed in this chapter are as follows:

• “Connection to the power meter, VFL and Talkset” on page 32

• “Using the Power meter” on page 32

• “VFL Function” on page 39

• “Storing and reloading results” on page 40

• “Talkset and Datalink Functions” on page 41
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Connection to the power meter, VFL and 
Talkset

The type of optical connector used for the power meter is UPP (Universal 
Push Pull), which is compatible with all diameter 2.5 mm connectors (FC, 
SC, ST, DIN, E2000, etc.)

Using the Power meter
The power meter function is an option chosen at the time of order and 
incorporated into the 2000 Platform in the factory.

To activate the function:

1 Press the HOME button

2 Activate the power meter icon of the Platform .

Figure 12 Optical connectors

Accuracy of measurements

A high degree of accuracy is often required. It is then nec-
essary to perform a preliminary calibration without the fiber 
under test to eliminate the losses due to connections as far 
as this is possible. To do this, use the «Reference Value» 
function.

Power meter 
optical connection

VFL



Chapter 5 Power meter, VFL (Visual Fault Locator) & Talkset
Using the Power meter

User Manual 79000000203 Rev. 005 33

The effect of this action will to be to bring the power meter into use 
and to display the Results page for Power Meter.

Configuring the power meter
Configuring measurement parameters

The measurement parameters can be accessed with the SETUP key.

Wavelength Selecting wavelength:
- Auto: the wavelength of the input signal will be
automatically detected and selected to perform the
measurement:
850, 980, 1300, 1310, 1420, 1450, 1480, 1490, 1510,
1550 or 1625 nm: measurement performed at
specified wavelength.
- User: choice of wavelength on the next line

User choice (if the User option was selected in the Lambda line)
enter the wavelength between 800 and 1650 nm,
using the numeric keypad, displayed via the Edit
Value key.

Beep on Modulation
Select if a sound must be heard when a modulation
occurs (Yes / No)

Unit Unit of power displayed:

Figure 13 Configuration of power measurement
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- Watt, dBm for displaying absolute power

- dB for displaying a result relative to a reference (link
loss)

Reference level If dB units were chosen in the previous line, selection
of the reference value for the wavelength selected.
First select the wavelength, then press the > key to
access choice of the value (+XXX.XX).

This reference is also automatically available, in the
Results page, using the Set as Reference key.

Attenuator compensation
Choice of level to be applied to the wavelength chosen
for measurement to compensate for the loss due to the
external attenuator (+XX.XX dB). First use the
direction keys to choose the wavelength, then press >
to access choice of value.

Configuring the alarm parameters of the power 
meter
Alarm Activation of the Alarm function: any result below the

lower threshold or above the upper threshold will be
displayed in red on the Results page.

Min and max thresholds:

Choice of lower and upper thresholds for each
available wavelength, from -60 to +40 dBm (selected
with the direction keys).

NOTE

To copy a Reference Level or a Attenuator Compensator 
on all wavelengths, select the reference wavelength and 
click on Update for All Wavel.
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Display of results and commands
The results page called up by the RESULTS button, gives the information 
relating to the measurement in progress, results previously saved and the 
commands available for measurement and saving.

Result of the measurement in progress

The power measured by the power meter is displayed in large characters, 
in the units selected in the SETUP menu, together with:

• the mode of transmission of the signal measured: continuous (CW) 
or modulated to a frequency of 270Hz, 330Hz, 1KHz, or 2KHz.

• the wavelength of the signal measured. 

• the reference level expressed in dB.

• the level of Attenuation Compensation.

Table of results

For one and the same fiber, the power meter displays a table of 9 results 
corresponding to the different possible wavelengths. The first 4 results are 

NOTENOTE

To copy one value of the Lower or/and Upper threshold for 
all wavelengths, select the reference value and click on 
Update for All Wavel..

NOTENOTE

A continuous push on direction keys increments the value 
by 10 dBm.
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displayed on the screen; to scroll through the other results, use the direc-
tion key . The table shows the power measured in dBm, the relative 
power (in dB) and the reference level in dBm (if units = dB), together with 
the mode.

• A measurement result is displayed in the table when the Keep 
Result softkey is pressed. 

• The Clear Table softkey orders deletion of all the results displayed in 
the table. 

• If the Alarm function has been activated, any result that exceeds the 
selected thresholds appears in red in the table. Otherwise, results 
are shown in the table in green.

• When the instrument is switched off, results present in the table are 
saved.

Commands of the power meter parameters

When the Powermeter function is selected, the following softkeys are avail-
able on the results page:

The different configuration buttons are displayed:

Wavelength selection of the wavelength

Unit choice of the unit

Figure 14 Results and commands of the power meter

Results of the 
powermeter
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Zero Adjustment of the Zero value when the power meter’s
optical input is closed with a plug (a validation is
required).

On the results page, the following actions are available:

Standard Reference
Selects the current result as reference value to
measure the attenuation of a link. This reference is
displayed under the measurement result until a new
reference value is chosen.

Keep Result Saves the result on the corresponding line of the table.

Clear Table Deletes all the results recorded in the table.

If the Source function is selected (either on this Platform, on the base Unit 
or on an OTDR module, or on another Platform), the Power meter results 
page is different:

• The Wavelength, Unit and Zero menu keys are accessible via the 
menu key Power Config.

• The Power Ref. menu key allows to reach the Standard Ref menu 
key. It also allows to reach the Jumper Ref menu key if Power meter 
function is associated with Source function onto another unit (see 
2100/4100 Module User Manual).

Performing a measurement
The power meter is started up as soon as the function  is activated 
in the HOME menu.

Power measurement is automatically updated in conse-
quence. The value «<-60 dB» is displayed when the laser 
is switched off and if the source output is looped on to the 
power meter input.
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Power measurement
1 Connect the light source to be tested to the rear connector (see 

"Connection to the power meter, VFL and Talkset" page 32).

2 In the SETUP menu, choose the units dBm, dB or Watts.

3 Press the START/STOP key to start the measurement. 

The result will appear in the results page and can be memorized in 
the table (see "Table of results" page 35).

4 Press the START/STOP key to stop the measurement.

Optical link loss

Setting the zero value of the power meter

1 Fix the plug over the optical input of the power meter so that no light 
can reach the photodiode of the power meter. If the zero adjustment 
is made without this plug, an error message may be displayed, as the 
photodiode will detect too much light.

2 In the Results page, press the Powermeter Config. > Zero soft key 
and validate.

Carrying out the reference measurement

1 Fix the adapter corresponding to the jumper to the optical connector 
of the power meter.

2 Connect the jumper between the input of the power meter and the 
output of the source.

It is important to set the zero of the power meter before 
making any measurements where accuracy is required, as 
the noise from the germanium photodiode fluctuates over 
time and with variations in temperature.
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3 Configure the same wavelength on the source and the power meter.

The power measured is displayed in the results page of the power 
meter.

4 Press the Standard Ref soft key to save the result displayed as 
reference value.

Measurements on the fiber under test

After defining the reference value, proceed as follows to make the 
measurement:

1 Fix the jumpers and connectors needed to connect the fiber to be 
tested between the source output and the power meter input.

2 In the set-up menu, select dB units.

3 The power displayed in the Power Meter window corresponds to the 
optical loss of the link tested. It can be displayed in the table (see 
"Table of results" page 35).

VFL Function

VFL connector
The type of optical connector used for the VFL source is UPP (Universal 
Push Pull), which is compatible with all diameter 2.5 mm connectors (FC, 
SC, ST, DIN, E2000, etc.)

See Figure 12 on page 32 to visualize the VFL connector.
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Visual Fault Locator function (VFL)
This function is used to emit a red light signal of frequency 1 Hz or in contin-
uous mode into a fiber to detect any defects in the dead zone of the reflec-
tometer, or to identify it. 

This function is suitable for short fibers (length < 5 km) or the first few 
metres of a long fiber.

To emit a light signal into a fiber:

1 Connect the fiber to the VFL port on the connectors panel.

2 Press the HOME key and activate the VFL 

The icons  display on the upper banner of the screen.

The signal mode of the VFL can be modified in the System Settings page, 
in Utility > VFL Mode parameter.

Storing and reloading results

File Setup
Click on the button FILE to access the File setup. See the chapter «File 
management» in the user manual «2100 modules series» for a complete 
description of all parameters, options and description of the explorer.

NOTE

Identification is facilitated by the blinking of light in the fiber.
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Storing results
In order to save the results of a measurement, click on FILE and select 
Store trace. Two files are being saved:

• The first file is used with the 2000 Platform and allows to retrieve all 
measurement results. It is saved with the extension «.Lts».

• The second file is a ASCII file using tabulations to separate values. It 
is saved with the extension «.txt» and can be opened by the 2000 
Platform. It has been designed to be used with a spreadsheet 
program on a PC where it allows to retrieve all measurement results 
and format them in a nice customized table. 

Loading results
In order to load the results of a measurement, select a file  with the 
extension «.Lts» in the file explorer (see the chapter «File management» in 
the user manual for «2100 modules series»), click on Load. 
The LTS tab is displayed with the loaded results in the table

Talkset and Datalink Functions
The Talkset option enables two operators at opposite ends of an optical 
link:

• To communicate along the fiber.

• To transfer data along the fiber. 

Each end of the optical link must be provided with a 2000 Platform 
equipped with the Talkset option.
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Talkset configuration
The talkset configuration is set in the System Settings screen, in the 
Channel box (see "Defining the Audio parameters of the 2000 Platform" 
page 28)

Connections
At each end of the fiber:

1 Connect the fiber to the Talkset port of the 2000 Platform, either 
directly or through jumpers.

n

NOTE

It is possible to use the talkset of the 2000 Platform and to 
carry out measurements at the same time, on a different 
fiber.

NOTE

It is possible to use the Data transfer feature while using 
the optical telephone of the 2000 Platform. Nevertheless, 
the data transfer speed will be slightly decreased.

NOTE

The Talkset option is delivered with a FC adapter mounted 
on standard on the talkset connector.

In addition to the FC adapter, a SC adapter is also deliv-
ered with the Talkset option.
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2 A headset (with earphones and a microphone) supplied with the 
option may also be plugged into the 2000 Audio jack.

Establishing communication
On the caller 2000 Platform, press the HOME button, then validate the 
desired function:

• Talkset (Optical Telephone): used to communicate via the 
fiber.

• Datalink : used to transfer data along the fiber.

If the remote instrument is ready to receive (on standby), the Talkset/Data-
link icon turns yellow, beeps are emitted, and

Viavi recommends you to use the following connec-
tions:

- PC Fiber Connection (APC is not recommended)

- SC or FC connection (UPP is supplied but not recom-
mended).

Figure 15 Installation for Talkset use

NOTE

Data transfer uses the same fiber as the optical telephone
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• the icon  appears at the top of the screen: telephone communica-
tion can now take place. 

• the icon  appears at the top of the screen: data transfer can now 
take place.

If the remote instrument is not ready to receive, the icon does not change 
color and a message is emitted.

Adjusting volume level
The sound is transmitted to the earphones of the headset and, if this func-
tion has been activated, to the speaker in the 2000 Platform. To activate 
the base loudspeaker and adjust the volume:

1 Press the HOME key.

2 Validate Settings icon to reach the System Settings page.

NOTE

The talkset icon is displayed on the top banner as long as 
communication remains established, letting the user know 
that the connection is working.
When communication is established, the headset is auto-
matically enabled if plugged in. However, the loud speaker 
must be correctly configured in the setup menu to work 
accordingly 

NOTE

Data transfer varies according to the type of application you 
use. For Fiber Optics for example, you can use the 
explorer. The distant 2000 Platform will be shown just like a 
disk and all file and directory features can be used from 
and to that disk.
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3 Under the Audio box, adjust Hands-free Volume and/or Headset 
Volume (from 0 to 100). 

Disconnection
When communication is over: 

1 Deactivate the Talkset/Datalink function on one of the 2000 Plat-
form. 

This deactivation can be done by either 2000 Platform.

2 Then, the fiber used, can be disconnected safely.
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Chapter 6Scope

The scope function is a hot-plug feature enabled directly when inserting a 
Viavi scope supplied as an accessory (see:

The topics discussed in this chapter are as follows:

• “Scope feature” on page 48

• “Installation of tips” on page 49

• “Configuring the P5000i Scope” on page 49

• “Starting up with the scope” on page 55

• “Launching a test of the connector and fiber end-face” on page 57

• “File menu” on page 62
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Scope feature

Overview
This feature enables you to verify that your optical connectors are in perfect 
shape and very clean condition.

The P5000i Digital Probe Microscope is a portable handheld microscope 
used to view and inspect both the bulkhead (female) and patch cord (male) 
sides of fiber connectors as well as other optical devices, such as trans-
ceivers.

The P5000i requires an FBPT inspection tip and is connected to the 2000 
Platform with a USB 2.0 connector.

Figure 16 P5000i Probe components

QuickcaptureTM button
Instantly captures (and analyzes) fiber image
Focus Control

Latch lock
Squeeze both ends to release

Barrel assembly USB 2.0 
connecto

6 FT COIL Cable

Inspection tip

Magnification Control

Before using the P5000/P5000i scope, make sure the 
Bluetooth option has not been activated, even once, 
after the start of the MTS/ T-BERD 2000. If it has been 
activated, stop and restart the equipment before using 
the P5000/P5000i Scope.
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Installation of tips
The Pass/Fail analysis function on the 2000 Platform can only be used with 
certain inspection tips mounted on the P5000i.

Seven tips, patchcords and bulkheads types, are delivered with the Video-
scope Kit (EDFSCOPE5KI) but many others can be used.

Configuring the P5000i Scope

Scope connection
1 Plug in your Viavi scope into a USB port from the 2000 Platform.

2 Push the button Home

3 Validate the Scope function .

4 Connect probe with the fiber being inspected.

You may select this option while other options are already selected (e.g. 
OTDR).

Configuring the Scope
1 Press SETUP key to configure the test.

The following screen displays:
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Test

On the line Profile, select the Profile which will be used for the test of fiber 
connector:

• SM_UPC: Pass/Fail criteria for single-mode UPC connectors from 
IEC 61300-3-35 standard.

• SM_APC: Pass/Fail criteria for single-mode APC connectors from 
IEC 61300-3-35 standard.

• SM_PC: Pass/Fail criteria for single-mode PC connectors from IEC 
61300-3-35 standard.

• MM_: Pass/Fail criteria for multimode connectors from IEC 61300-3-
35 standard.

Profiles contain the analysis parameters by which PASS/FAIL criteria are 
determined.

Once the line is selected, you can also add a new profile, clicking on the 
Add Button (see “Adding a new profile” on page 53).

Figure 17 P5000i Scope Setup
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Tip (only with P5000i Scope)

On the line Tip, select the tip set onto the scope to connect fiber for inspec-
tion.

Capture button (only with P5000i Scope)

This parameter allows to select the action of the Quick Capture button onto 
the Scope (see Figure 16 on page 48):

Freeze & Test pressing the button will automatically perform a test of
fiber and freeze the result

Freeze image pressing the button onto the Scope will automatically
freeze the live image.

Auto Center (only with P5000i Scope)

This parameter allows to select if the scope image must be centered on 
screen (select Yes) or not (select No).

File

The File box allows to configure the saving of scope results.

The Dir parameter is displayed in grey, and indicates the directory into 
which the results will be saved. To change the directory, press FILE hardkey 
and select another directory from the file Explorer page; then press SETUP 
hard key to return to Scope Setup page.

On the line Filenaming, use the edition keypad, which will display by 
clicking on the right arrow key, to enter a specific name for the file. You can 
enter manually a name and/or use pre-defined parameters (Fiber Id, Cable 
Id, Locations...).
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The line below Filenaming shows the name of the file according to the 
parameters entered.

In the Logo parameter, click on right arrow key and select in the Explorer 
a JPG file which will represent the Logo displayed on the upper left part of 
the report 

Fiber

The Fiber box allows to configure the fiber plugged to the scope.
On the line Fiber Id, use the edition keypad, which will display by clicking 
on the right arrow key, to enter a specific name for the fiber. 

On the line Fiber Number, use the numeric keypad, which will display by 
clicking on the right arrow key, to enter the fiber number.

On the line Change fiber Nbr, select if the fiber number must be modified 
after each results saving:

No: the fiber number is not modified at each saving

Increment; the fiber number is automatically incremented at each 
results saving

Decrement: the fiber number is automatically decremented at each 
results saving.

Figure 18 Edition keypad for filenaming

Pre-defined 
parameters for 
filenaming
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Link Description

The information entered in the Link Description window concerns the 
editing and/or the modifications of the cable and fiber parameters.

Cable Id This parameter allows to enter an identification of the
cable, using the Edition menu.

Direction The direction shows if the acquisition has been made
from the origin to the extremity (A->B) or from the
extremity to the origin (B->A). Changing direction
makes it possible, when different extremities are
handled, to see the parameters of the fiber for the
other extremity.

Location A The name of the Location A of the link may be entered.

Location B The name of the Location B of the link may be entered.

Company Enter the name of the company carrying out the test.

Operator Enter the name of the operator carrying out the test.

Press Exit to return to the Results screen of the scope.

Adding a new profile
Once the Setup screen of the scope is displayed, you can add a specific 
profile which will be used for the test.

The profile must be created via FiberChek2TM, and stored on one storage 
media of the MTS/T-BERD 2000 (disk, or USB memory stick).

1 On the Setup screen, select Profile and press Add key.

NOTE

All parameters of the Link Description box will appear in the 
pdf report or jpg file generated from a test results page.
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2 On the explorer, select the file which will be used as profile (icon  ; 
extension: .PRO)

3 Press Load. 

Once loaded, the display goes back automatically to Setup screen.

4 Select the profile just loaded.

Removing a profile

1 In the Profile list, select the profile to be deleted.

2 Press Remove key, then Exit.

About page
On the Setup screen, the softkey About, on the right of the screen, allows 
to display information on scope and current test result displayed (in Full 
Screen mode or mosaic mode - see “Mosaic Mode” on page 59).

1 Press About softkey to display a page as the following one:

Figure 19 P5000i Scope: About page

Information on 
scope used

Information on 
active snapshot
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Starting up with the scope
Once the FiberScope icon is validated:

1 Press RESULTS hard key

Use the Focus Control button onto the P5000i scope (see Figure 16 on 
page 48) to adjust the image quality and sharpness.

Freeze mode
Once the image is acceptable, you may freeze the picture. This feature 
allows to store in memory the resulting picture.

Figure 20 Example of the result using the P5000i scope

NOTE

To switch from Scope page to FO results page and vice-
versa, press the RESULTS hard key for about 2 seconds (a 
beep is emitted).

Sharpness 
level
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High Mag. / Low Mag.
The High Mag./Low Mag. menu key allows to switch the display from High 
to Low magnification and vice-versa.

This function is also available pressing the button directly on the P5000i 
(see Figure 16 on page 48). 

Camera mode
If you are in Freeze mode, or in Mosaic mode, with a picture selected (see 
“Mosaic Mode” on page 59), press Camera menu key to return to live 
camera picture.

Freezing a scope result does not store the picture in a 
file (see “File menu” on page 62). The result will be lost 
if the instrument is shut off, or if more than 3 pictures 
are frozen (see “Mosaic Mode” on page 59)

NOTE

The button set on the lead, or the QuickCapture™ on the 
P5000i allows to freeze the picture or to take a snapshot.

Use the focus control to adjust the focus of the image
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Launching a test of the connector and fiber 
end-face

Launching a test of the connector and fiber 
end-face

Once the display is correctly adjusted (magnification, sharpness...), a test 
of fiber connector can be launched.
To launch the test:

1 Press Test key to launch the test of plugged fiber connector.

The test is completed:

– once the Led Testing is no more lit in red

– once the icon  is no more displayed on the upper banner

– once a screen as the following one displays:

NOTE

To configure Pass/Fail criteria, see "Configuring the Scope" 
page 49.
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A summary of test results is displayed on the right, upper part of the screen.

• Zone A: Core zone: it is the area surrounding 
the core

• Zone B: Cladding zone. It surrounds the 
majority of the fiber cladding.

• Zone C: Epoxy ring.

• Zone D: Ferrule/Contact zone: it identifies a 
portion of the ferrule near and around the fiber

Figure 21 Test results

Test result 
in High 
mag.

Profile selected 
in the Setup 
page

Summary 
of Test 
results

NOTE

To return to a Live Camera image, press the Camera key; 
or press the Full Screen/Mosaic key view both the live 
image and a test result simultaneously.

In Mosaic mode (see "Mosaic Mode" page 59), the result 
of the test only displays Pass or Fail information; the status 
of each zone is displayed only in full screen mode.

Zone 
Zone 

Zone 

Zone 
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Overlay
The Overlay key allows, when selected, to display the limits of each zone 
and to display with colors the defaults on the image.

When the key is deselected, the zones and defaults are not graphically 
identified.

This function is also available in Mosaic Mode (see “Mosaic Mode” on 
page 59).

Mosaic Mode
It is possible to display only one picture in full screen (640 * 390 pixels) or 
up to four pictures (320*180 pixels each, including the live camera picture) 
in mosaic mode. Use the key Full scr./Mosaic to switch from one mode to 
another.

Figure 22 Mosaic mode

Position 1 :
LIVE CAMERA

Position 2:

Selected 
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• You may select one of the pictures by clicking on it.

The selected picture is framed in green.

The tool bar on the right varies according to which picture is selected 
(camera, or static picture):

Picture selected: Camera

Test Allows to launch a (new) test of the connector (see
“Launching a test of the connector and fiber end-face”
on page 57) 

Freeze The live picture from the camera is frozen but does not
replace the live picture at position 1. The new
snapshot is placed at the second position, and all
existing pictures are pushed to the next position.

High mag./Low mag.allows to modify the live display from high to low
magnification and vice-versa

Picture selected: Image

Comment allows to add a comment to the selected picture (see
“Adding a comment” on page 61)

Save allows to save the selected picture in the directory
Scope, in the disk of the Platfom. Press Save key,
enter a name for the jpg file and validate. This key is
not available with jpg files other than those resulting
from scope application.

Overlay allows to display or hide the limits of each zone and
the defaults on image from a test result (see “Overlay”
on page 59).

If all positions were taken, the picture that was once at the 
fourth position is unloaded from memory. Frozen pictures 
and snapshots are lost, unless they were saved on the 
internal memory.
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High mag./Low mag.allows to switch all the images from scope test
results from high to low magnification and vice-versa.

Adding a comment

The key Comment allows you to enter/modify a comment to your picture if 
necessary. This comment appears at the bottom left of the picture. 

The right bottom of the frozen picture also contains the date of the acquisi-
tion (where the picture was frozen).

Loading a picture
It is possible to retrieve and load a picture stored in the Scope directory and 
display it in the Scope page.

1 Press the FILE button.

2 Press Explorer. 

3 Select the JPEG file to be loaded via the Explorer

4 Click on Load

Recognized pictures are images resulting from the Scope option and saved 
on disk via the 2000 Platform.

NOTE

Both the comment and the date will be saved with the pic-
ture.

Some pictures resulting from the Scope option may 
appear nevertheless unrecognized, if they have been 
stored with a different Scope application, or if the JPG 
file has been opened and modified under another JPG 
editor.
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Even though the JPG editor of the Scope function has been designed to 
display Scope pictures in black & white, it is also possible to open any JPG 
valid file and display in color the corresponding picture. That picture is 
enlarged or shrunk to the size of the display (full screen or mosaic, 
see."Mosaic Mode" page 59).

File menu

Saving the test result in a jpg file
Once the test has been performed, and the result is displayed on the 2000 
Platform screen:

1 Press FILE key

2 Click on Save key to save a jpg file of the test result on the disk of the 
2000 Platform.

3 On the edition keypad, enter the name of the jpg file

4 Press Enter to validate.

The file is automatically saved on the disk, in the directory Scope 
(icon ).

Generating a report
1 Check the correct test result is selected (framed in green in mosaic 

mode).

2 Press the FILE button, then the Report key

3 On the edition keypad, enter the name of the pdf file and press ENTER.

The report generation is completed once the icon  is no more 
displayed on the upper banner.
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Display of the report

Once the report has been generated:

1 Press FILE hard key.

2 On the right menu keys, press Explorer soft key.

3 In the File Explorer, select the pdf report just created.

4 Press Load.

NOTE

The pdf report will be saved on the disk, in the directory 
Scope.
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Figure 23 PDF report of Scope test result

Logo, company & param-
eters selected in the 
Setup page (see “Config-
uring the Scope” on 
page 49)
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Chapter 7Transferring the 2000 

Platform Interface

The 2000 Platform can be used in combination with a PC in order to 
transfer the Platform Interface onto a PC, or to access the internal memory 
or USB memory stick contents on the PC. 

Topics described in this chapter are as follows: 

• “Establishing connection” on page 66

• “Transferring the Interface” on page 69

• “Virtual control buttons bar” on page 70

• “Equivalence between the keyboard and 2000 Platform” on page 71
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Establishing connection
The connection between 2000 Platform and the PC can be done directly, 
or via a local network.

The transfer of the interface can be done using a VNC window on PC.

Connecting the 2000 Platform and the PC
1 Connect the 2000 Platform to the PC via an Ethernet cable, using the 

RJ45 connectors set on both equipments.

2 Check the network connection on the PC is set in Dynamic mode.

Configuring the 2000 Platform
1 In the Home page of the 2000 Platform, validate the Settings icon.

For an intensive use of the deport screen or when it is 
used via a WAN network, it is strongly recommended 
to use a dedicated VNC client. The VNC clients recom-
mended are Tight VNC (V 1.2.9 or later) and Real VNC 
(V 4.1.1 or later).

Figure 24 Connection 2000 Platform and PC
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2 In the System Settings page, in the I/O Interfaces box, configure 
the following parameters:

Remote Screen

Remote screen = Session or Permanent must be confirmed in both 
cases, in the Interface E/S window.

No the screen cannot be remote on to a PC or on to
another 2000 Platform.

Session Mode the Remote screen function is inactive once the 2000
Platform is switched off.

Permanent Mode the Remote screen function is still active when the
2000 Platform is switched off and restarted.

Permanent with password 
same function as the Permanent mode, with an
access to the equipment via VNC protected by a
password: 42000

The password to access VNC can be modified:

1 Click on the menu key Change password.

2 Enter the current password in the Edition keypad and press Enter to 
validate.

3 Enter the new password and press Enter to validate.

Ethernet > Mode

Parameters of the local Ethernet network to which the 2000 Platform is 
connected:

Config 1 to 4 static mode enabling input of the configuration of 4
sites. If this parameter is selected, the following
parameters must be entered:

– Site Name the user can enter the name of the site in the Edit menu.
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– IP Address IP address of the 2000 Platform

– IP Mask address of the mask of the sub-network

– IP Gateway IP address of the machine enabling access outside the 
sub-network.

– DNS1 IP address of the machine providing the IP address on 
the basis of the name

– Domain namename of the local network to which the 2000 Platform 
is connected.

Dynamic in this mode, which requires a DHCP server, the 2000
Platform requests an IP address from this server
which will be allocated dynamically if dynamic host
configuration is activated on the local network.
After selecting this mode or after power-on, the 2000
Platform tries to establish a connection to obtain an
address from a DHCP server. If for any reason, this
process fails, the 2000 Platform reverses to static IP
address mode with User1 IP address.

Proxy > Use proxy

1 Select No if no proxy is used.

2 If Manual has been selected, enter the Proxy Address.

3 If Auto has been selected, enter the Pac Address.

1.Domain Name Server

NOTE

Once the 2000 Platform is connected to the network, the 
icon  indicates the connection is working.
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1 Note the IP Address displayed in the System Settings page.

2 Wait about 10 seconds the connection is established.

The 2000 Platform Interface can now be transferred onto the PC, or the 
internal memory or USB key contents can be transferred on PC.

Transferring the Interface
Once the connection is established between the 2000 Platform and the PC, 
proceed as follow:

1 Open Internet Explorer on the PC.

2 Considering 10.33.18.93 is the IP Address of the 2000 Platform (as 
shown Figure 25 on page 69), enter the following address in the 
Internet Explorer window:

http://10.33.18.93:5800
3 Press Enter to validate.

A VNC window opens, demanding a password 

4 Press OK without typing any password.

The screen of the 2000 Platform appears offset on your PC.

Figure 25 Example of configuration for I/O Interfaces box

Note the 2000 Plat-
form IP Address
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You can use keyboard mouse of the PC to control the 2000 Platform (see 
“Equivalence between the keyboard and 2000 Platform” on page 71).

Virtual control buttons bar
It is possible to emulate hard keys with Virtual Control buttons. This virtual 
control buttons bar is especially useful when the 2000 Platform screen is 
exported on a remote PC.

To display those buttons, click once on the top of the screen in the status 
bar, at the same height than the date and time.

Figure 26 VNC window

NOTE

Once Remote screen is accessible via VNC, the icon  
displays on the upper banner of the screen until the con-
nection is cut or the 2000 Platform is switched off.

Click to install TightVNC soft-
ware on your PC (not manda-
tory) 
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The virtual control buttons bar is displayed during a few seconds. You may 
click on any of these buttons to obtain exactly the same results than using 
the hard keys on the front panel of the 2000 Platform.

Equivalence between the keyboard and 
2000 Platform

The PC keyboard can replaced all the buttons and keys of the 2000 Plat-
form except the ON/OFF button: 

• The menu keys to the right of the screen are replaced by the function 
keys F1 to F6.

• The buttons below the screen are equivalent to Ctrl + a letter (see 
table below).

• The direction keys have the same function on the external keyboard 
and on the 2000 Platform.

Figure 27 Virtual control buttons bar

Function on the 2000 Platform External keyboard 

HOME Ctrl + H

SYSTEM SETTINGS F12

SET-UP Ctrl + U

FILE Ctrl + F

RESULTS Ctrl + R

START/STOP Ctrl + S

EXPORT Ctrl + Pa

←  ↑  →  ↓

Menu keys 1 to 6 (from top to bottom) F1 → F6
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ABOUT F11

Save and quit (Exit) Entrée/Enter

Quit without saving (Abort) Escape/Echap.

a. The Export function is available directly on the 2000 Platform pushing simultaneously 
the left and right arrow keys.

NOTE

Those equivalences are also valid with a keyboard directly 
connected to the 2000 Platform via one USB port.

Function on the 2000 Platform External keyboard 
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Chapter 8Stratasync

This chapter describes how to synchronize your 2000 Platform to the 
Stratasync application. 

The topics discussed in this chapter are as follows:

• "Principle and prerequisites of the Stratasync" page 74

• "Configuring and synchronizing the 2000 Platform" page 75
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Principle and prerequisites of the Stratasync
Stratasync is a new solution that provides network operators with an agile 
and centralized way to manage and analyze data from thousands of 
deployed Viavi test instruments directly from the cloud.

StrataSync is a hosted, cloud-based software application that provides 
Viavi instrument asset, configuration, and test-date management.

StrataSync improves technician and instrument efficiency. 

StrataSync allows to: 

• Manages and tracks test instruments

• Collects and analyzes results from the entire network

• Informs and trains the workforce

Figure 28 Principle of the Stratasync application

Instruments are dialed in: 
the latest configurations 
and software

Techs are empowered: 
“right the first time” with 
the latest test instruction

Visibility throughout 
the entire network:  all 
results are immediately 
useful

Lots of data in

Simple 
data out
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Pre-requisites for using the Stratasync with the 2000 
Platform

The user must have subscribed to Stratasync, and by consequence, he 
must have acquired an account Identifier and a password.

The Ethernet and Proxy parameters must have been correctly configured 
in the System Settings page of the 2000 Platform (see “Ethernet > Mode” 
on page 67 and “Proxy > Use proxy” on page 68).

Configuring and synchronizing the 2000 
Platform

The 2000 Platform can be configured to be synchronized with the Strata-
sync.

1 Press Settings in the Home page

2 Check the configuration of the Ethernet and Proxy parameters.

3 Configure the Stratasync parameters:

a In the Server Type parameter, the Viavi Server is selected by 
default and it is recommended to keep this parameter.
However, the user can select if necessary the Server Name 
parameter and enter the name in the following parameter.

b In the Account ID parameter, enter the same identifier as the 
one used to access to Stratasync.

c The Technician ID parameter is automatically fulfilled after 
synchronization (if it has been defined by the administrator of 
the Stratasync)

d To upload the files from a directory onto the 2000 Platform 
toward Stratasync, select the parameter Upload from and press 
right arrow key to enter the directory path (example: disk/
Stratasync). The directory Stratasync is defined by default.
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Connecting the 2000 Platform to Stratasync
Once 2000 Platform is configured in the System Settings page:

1 Press Expert Tools > Upgrades menu keys.

2 Press Stratasync menu key .

The synchronization with Stratasync starts

The icon  displays on the upper banner of the 2000 Platform 
during synchronization.

Once the icon is no more displayed, this mean that the synchroniza-
tion is completed.

3 For the first synchronization only, a message displays on the 2000 
Platform to indicate the addition of the equipment in Stratasync.

Figure 29 System Settings - Stratasync

2
3
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The 2000 platform is now available in Stratasync.

Figure 30 First synchronization - Message on 2000 Platform
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Chapter 9Web browser

The 2000 Platform allows to access to internet, using the Web Browser 
installed on the equipment.

The topics discussed in this chapter are as follows:

• "Configuring the Web access" on page 80

• "Starting the web browser" on page 80

• "Creating bookmarks" on page 83

• "Opening a PDF document" on page 83

• "Leaving the web browser" on page 84
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Configuring the Web access
Before using the Web Browser onto the 2000 Platform, check/modify the 
proxy configuration in the System Settings page:

1 On the Home page, press Settings key

The System Settings page displays.

2 Select Proxy parameter in the I/O Interfaces box to open a sub-
menu.

3 Configure the parameter User Proxy

– If Manual is selected, enter the Proxy Address with edition keypad

– If Auto is selected, enter the Pac Address using the edition 
keypad.

Starting the web browser
1 In the Home screen, select Web Browser  icon.

The web browser is launched.

Figure 31 Proxy configuration
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Opening an internet page
Once the Web Browser is displayed, you must enter the internet address.

1 Set the cursor in the address bar:

a Use the mouse connected via USB port on the 2000 Platform or 
the mouse of the PC if the screen is deported via VNC applica-
tion on the PC, or use the touchscreen.

b Click on the menu key  so that it becomes . This allows 
to move the cursor toward the address bar.

2 Once the cursor set onto the address bar, enter the address:

a Using a keyboard connected to the 2000 Platform USB port or 
the keyboard of the PC with a deport of the screen via VNC, 
enter the entire address of the site to be opened.

b If none keyboard is available:

– click on the menu key  to display the virtual keyboard and enter 
the address using the buttons on the 2000 Platform or clicking 
directly on characters.

3 Push the ENTER hard key.

The page opens

Figure 32 Web Browser page



Chapter 9 Web browser
Starting the web browser

82 User Manual 79000000203 Rev. 005

If an error message is displayed in place of the internet page, verify 
the address you typed, or check the configuration (see "Configuring 
the Web access" on page 80).

Navigation into the Web Browser
Once the Web Browser is open,  press the key   to display on the right 
of the screen, the buttons used to navigate.

When a link is available, the arrow cursor becomes a hand cursor

Figure 33 Internet page opened with the Web Browser

Icon Definition

Go to the previous or next page loaded

Refresh the actual page

Exit the Navigation menu
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Creating bookmarks
Once a page is opened, you can apply it a bookmark, in order to get a 
shortcut toward this page.

Once the internet page for which a bookmark must be created is opened:

1 Click on  to open the dialog box for bookmarks creation..

A new tools bar is displayed on the right of the screen.

2 Click on menu key  to add a bookmark for the page displayed

3 Click on  to edit the bookmark, and modify if necessary the name 
of the bookmark. Click on Ok to confirm the modification or Cancel to 
cancel the modifications.

• Click on  to open the page of the bookmark selected in the list

• Click on  to delete the selected bookmark from the list

• Click on  to exit bookmark menu and go back to Web Browser.

Opening a PDF document
PDF documents may be opened and read within the Web browser.

1 When you click on a link toward a PDF file, a dialog box during 
loading is displayed.

2 Once loading is completed, click on Ok to open the pdf file.

Figure 34 Bookmark edition
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Click on the menu key  to go back to the web browser.

Leaving the web browser
Depending on how long you want to leave the web browser and on your 
connection mode, you may:

• Leave the web browser running and switch to another task. To do 
this, click on the HOME button. 

The web application is still running in the background. Nevertheless, 
you have now a complete access to all the 2000 Platform functional-
ities.

To go back, you must select again the Web Browser in the Home 
page. The application will reopen much faster, and all your environ-
ment will be the same (last current page, possibilities to go back...)

• Quit the application using the Web browser application menu: click 
on the key .

Figure 35 Downloading a pdf file

NOTE

The web browser will open a PDF document, not a URL 
including a PDF file.

The PDF is also automatically saved on the disk of the 
Platform.
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Chapter 10File management

The files management with the 2000 Platform can be performed, wether a 
module is set onto the 2000 Platform or not.

The topics discussed in this chapter are as follows:

• “File Explorer Overview” on page 86

• “Directories and Files selections” on page 86

• “Directories & Files editing functions” on page 88

• “Working with directories and files from the explorer” on page 90

• “Creating a screenshot” on page 102

• “Creating a report” on page 103

• “Merging pdf or txt files” on page 105

• “Storage media” on page 107
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File Explorer Overview
To reach the File Explorer page

• On the Home page, select the File Explorer icon.

The File Explorer page appears.

Directories and Files selections

Directory selection
To select a directory from the explorer page:

1 Press on the directory that must be selected on the left of the screen.

The list of files the directory contains displays on the right side of the 
screen

The selected directory is underlined in blue

Figure 36 File Explorer page
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2 Click on the arrow at the left of the directory name, or press validation 
hard key  , to display the sub-directories if any.

Files selection
To select one or several files from the explorer page:

1 Press on files that must be selected.

or

To select a list of files using the keys of the Platform:

a Select and validate the first file of the list (underlined in red)

b Set the cursor on the last file of the list (underlined in blue)

c Maintain the right direction key  pushed until all the files are 
selected.

or

Click on Select all menu key to select all files into the directory.

Figure 37 Directory selection

Selected directory

Sub-directory

Access to 
sub-directory

NOTE

The last selected file is underlined in red and the previous 
one(s) selected is/are underlined in blue. 



Chapter 10 File management
Directories & Files editing functions

88 User Manual 79000000203 Rev. 005

Directories & Files editing functions

Copy/Cut & Paste files/directories
To copy (cut) one or several files, or one directory, and paste them in 
another place:

1 Select the directory / the file(s) (see “Directories and Files selections” 
on page 86).

2 Press Edit menu key

3 Press Copy to keep the directory / file(s) to their initial location.

or

Press Cut to delete the directory / file(s) from their initial location

4 On the left of the screen, select the directory; or select the new 
storage media.

5 Click on Paste menu key.

Figure 38 Example of files selection

Selected files

Selected 
directory
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Renaming a directory / file
1 Select the directory / file to be renamed (see “Directories and Files 

selections” on page 86).

2 Press Edit > Rename Directory or Rename File.

The Edition keypad displays.

3 Press Clear if you wish to delete the entire name

4 Enter a new name for the directory / file.

5 Click on Enter to validate the new name.

Deleting a directory / file
1 Select the directory or file(s) to be deleted (see “Directories and Files 

selections” on page 86).

2 Press Edit > Delete.

A confirmation dialog box displays.

3 Press Yes to delete the selected directory or file(s).

Press No to cancel the deletion.

Figure 39 Edition keypad for renaming file
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Working with directories and files from the 
explorer

Creating a directory
To create a new directory from the explorer page:

1 Check the cursor is set on the left of the screen

2 Select the storage media into which the directory must be created

3 If you want to create a sub-directory, select the directory into which it 
must be created.

4 Press the right menu key Create Directory.

The edition keypad displays

5 Enter a name for this directory

6 Press Enter key to validate the new directory

Opening files
Once a file is selected, press Load menu key.

Opening several files at the same time can be done 
exclusively with trace files (example: all OTDR trace 
files if a reference trace has been defined). Other type 
of files (PDF, TXT...) must be open one by one.

If different types of files have been selected in the 
Explorer, only the last one selected will open.
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File Types

For files recognized by the 2000 Platform, the types are symbolized by 
icons. E.g.

Icon Type of FO file

OTDR file (.SOR extension)

Multi OTDR file (.MSOR extension)

OSA file (.OSA extension)

Power Meter file (.LTS extension)

Icon Type of file

HTML file (.HTML extension)

PDF File (.PDF extension)

Text file (.TXT extension)

License file (.LIC extension)

CSV file (.CSV extension)

JPEG / JPG file (.JPEG extension)

PNG file (.PNG extension)

XML file (.XML extension)

With the 2000 Platform, you can open and load any 
kind of FO files (OTDR, OSA, PON, LTS) even if the cor-
responding module is not set into the Platform.
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Sorting files
Wether files are selected or not, the key Sort allows to access to a sub-
menu allowing to sort the file according to pre-defined parameters:

• Sort by name: the files display in an ascending order (from A to Z). If 
you click once again on the key, the files display in a descending 
order (from Z to A).

• Sort by size: by clicking once on this key, the files display from the 
smallest to the heaviest one. Clicking a second time allows to sort the 
files in opposite order.

• Sort by type: clicking once on this key; the 2000 Platform displays 
files in an ascending order (the file type A to file type W). By clicking 
again, the 2000 Platform displays the files in opposite order.

• Sort by date: clicking once on this key; the 2000 Platform displays 
files from the more recent to the less one. By clicking again on key, 
the Platform displays files from the older to the more recent one.

Transferring files between two Platforms
If some Results traces or other kinds of file need to be transferred to 
another Platform, or if files from another Platform must be transferred to the 
2000 Platform, this can be easily done using the USB cable delivered on 
standard with the equipment.

NOTE

You can also sort files clicking on the column titles in the 
files list



Chapter 10 File management
Working with directories and files from the explorer

User Manual 79000000203 Rev. 005 93

Establishing connection between two 2000 
Platforms
1 Connect the 2000 Platform to another one, plugging the USB cable 

on the mini USB port of the Platform toward a USB port on the other 
Platform.

1 Once connection is established, confirm that you wish to activate the 
USB link in the pop-up window on the 2000 Platform.

Figure 40 Direct connection 2000 Platform <-> 2000 Platform

NOTE

The connection can be done with a 4000 Platform on the 
other side.

Mini USB Port on 
the 2000 Platform

USB port 
on the Plat-

USB cable
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Transferring files
1 On the distant Platform, open the File Explorer page

The usbflash driver appears  on the left side of the screen.

2 Select the file(s) to be transferred from one Platform.

3 Press Edit > Copy or Cut softkeys.

4 Select on the left of the screen, the directory on the other Platform, 
into which file(s) must be transferred.

5 Press Paste softkey.

File(s) is/are transferred.

Cancelling the connection

Once all desired files have been transferred, connection between both 
2000 Platforms can be removed:

1 On the distant platform, press Eject USB key before removing USB 
plug from connector.

Figure 41 Confirmation of files export via USB cable
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2 On the 2000 Platform, remove the mini USB plug from its connector.

The screen displays the results trace of the active function, or returns 
to the Home page if no function is active.

Transferring files to a PC with the USB cable
If some Results traces or other kinds of file need to be transferred to the 
PC, this can be easily done using the USB cable delivered on standard with 
the 2000 Platform.

Establishing connection 2000 Platform <-> PC
1 Connect the 2000 Platform to a PC, plugging the USB cable on the 

mini USB port of the Platform toward a USB port on the PC.

1 Once connection is established, confirm that you wish to activate the 
USB link in the pop-up window on the 2000 Platform.

Figure 42 Direct connection 2000 Platform <-> PC

Mini USB Port on 
the 2000 Platform

USB port on the PC

USB cable
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A message displays on the bottom right side of the PC informing a 
new hardware is detected.

2 Click on the message and select «Open folder to view files» in the 
dialog box ViaviDISK (F:) («F:» is an example, it can be different 
according to your PC and to the USB port used).

The 2000 platform disk content opens onto the PC.

Figure 43 Confirmation of files export via USB cable

Figure 44 Open 2000 disk content
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Transferring files onto the PC
1 Select the file(s) from the 2000 Platform to be transferred onto the 

PC

2 Press Ctrl + C, or right click and select Copy.

3 On the PC, select the directory in which file(s) will be transferred.

4 Press Ctrl + V, or right click and select Paste.

Cancelling the connection

Once all desired files have been transfer onto the PC, connection between 
2000 Platform and PC can be removed:

1 On the PC, use the appropriate method to safely remove the USB 
cable from the USB port. 

The screen displays the results trace of the active function, or returns 
to the Home page if no function is active.

2 Remove the mini USB plug from the 2000 Platform USB port.

Figure 45 Files selection from the 2000 Platform
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Transferring files to/from a PC with a FTP server
Il is possible, from a PC, to access the internal memory of the 2000 Plat-
form or to the USB memory stick connected to the Platform by means of 
the FTP server of the 2000 Platform.

Direct connection
1 Connect directly the 2000 Platform to the PC with an Ethernet cable, 

using the RJ45 connectors on each equipment.

1 Make sure the network configuration onto the PC is set to the 
Dynamic mode:

a Click on Start > Control Panel.

b Double click on Network Connection.

c Double click on Local Area Connection.

d In the dialog box, click on Properties.

e Check the parameter Internet Protocol (TCP/IP) is selected 
( ) and click once on it (underlined in blue)

f Click on Properties button.

g On the tab General, check the parameter Obtain an IP address 
automatically is selected ( ); if not, click to select it.

Figure 46 Ethernet Connection 2000 Platform <-> PC

Ethernet 
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h Click on Ok and close all the dialog boxes opened onto the PC.

2 On the 2000 Platform, in the System Setup page, under I/O inter-
face > Ethernet, select Dynamic.

1 Note the IP Address and wait for about ten seconds while the 
connection is established.

Connection via a local network
1 On the PC: find the IP address and the mask of the PC’s sub-

network:

• With Windows 98 or Millenium: Select Start > Execute, then enter 
winipcfg and click on OK. 

• With Windows NT, 2000, XP or Vista: select Start > Programs > 
Accessories > Dos Prompt, type ipconfig", then Enter. 

Figure 47 Internet Protocol

Figure 48 System Setup > Ethernet: Dynamic mode

IP Address of 
the Platform



Chapter 10 File management
Working with directories and files from the explorer

100 User Manual 79000000203 Rev. 005

Note the IP address and the mask of the PC’s sub-network.

2 Plug the RJ 45 connector of the 2000 Platform into a hub or Ethernet 
switch with a straight-through Ethernet cable (see Figure 42 on 
page 95).

3 On the 2000 Platform: 
In the system set-up menu, under I/O interfaces > Ethernet, select 
Config 1 (or 2 / 3 / 4) on the line Mode, then enter the IP address, 
the IP mask of the PC and the IP gateway previously noted (step 1).

or

use Dynamic attribution mode (DHCP). In this case, the address of 
the 2000 Platform (10.33.18.235 in the example) is displayed but 
cannot be altered.

4 Wait for about ten seconds while the connection is established.

5 On the PC, make sure that the connection is operational by selecting 
Start > Execute... and typing ping followed by the address of the 
2000 Platform.

Accessing the internal memory of the 2000 Platform

FTP access is obtained through the user account «mts2000» (password: 
Viavi).

1 Make the 2000 Platform / PC connection as described Figure 46 on 
page 98.

2 On the PC, use an FTP client, and access to internal memory via an 
internet explorer (I.E, Mozilla Firefox...) or Windows Explorer.

3 In the address bar, type the following address (10.33.18.235, 
being the IP address of the 2000 Platform defined when the connec-
tion was configured; see Figure 48 on page 99):

ftp://mts2000:Viavi@10.33.18.235/disk/
This allows to access to internal memory.
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ftp://mts2000:Viavi@10.33.18.235/usbflash/
This allows to access to the contents of the USB memory stick 
connected to the 2000 Platform.

The PC then displays the contents of the internal memory or of the 
USB memory stick from the 2000 Platform.

1 If internal memory of the Platform is accessible via Internet Explorer 
(or any other explorer), right click on one file and click on Save target 
as... to transfer file onto the PC.

If internal memory of the Platform is accessible via Windows 
Explorer, select one / several files and click on Copy, then click on Paste on PC to 

transfer file.

If you use Internet Explorer 7, the following address must 
be entered:

ftp://mts2000:Viavi@10.33.18.235/acterna/user/
disk or ftp://mts2000:Viavi@10.33.18.235/
acterna/user/usbflash

Figure 49 Internal memory of the 2000 Platform

Internal memory open via Internet Explorer

Internal memory open via Windows Explorer
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Creating a screenshot
You can create captures of what is displayed on the screen, directly from 
the 2000 Platform.

Configuring the parameters of screenshots
To configure the screenshot and choose the format of the generated file:

1 Press HOME hard key

2 Select the Settings icon to reach the System Settings page.

3 In the Report box, on the line Mode, select Screenshot

Choosing this option, you can save the displayed screen in JPG, 
PNG or PDF format, exactly as it is displayed on the screen.

Therefore, if you make a zoom on the trace for example, the file will 
only show the zoom section.

4 On the line File format, select if the printed file will be a JPG, PNG or 
PDF file.

Taking a screenshot
Once the screenshot parameters are configured:

1 Reach the display which will be saved as a screenshot in a file.

2 If necessary, make modifications on this display (example: zoom on 
trace...)

3 Press simultaneously the left and right arrow keys  for about 5 
seconds

or

Click on the upper banner of the screen and, in the virtual control 
buttons bar, press Export key 
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The icon  displays until the end of process.

4 Press the FILE key to find the JPG, PNG or PDF file in the Explorer

Name of the screenshots files
The screenshot is saved in a file, which is automatically named as follow: 

• Print_date (year/month/day)_time (hour/minute/second).jpg/png/pdf

The file is saved in the directory Stratasync, on the storage media disk.

Creating a report
Once the results page of a function is opened (example: OTDR trace, 
Power Meter results...), it can be exported in a report, using the 2000 Plat-
form.

Figure 50 Example of screenshot, open in the Web Browser of the 2000 
Platform
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Creating the report
1 Open the file to be saved in a report in JPG, PNG or PDF format

2 If necessary, make the modifications on the file/trace (see user 
manual of the 2100 OTDR Modules for OTDR trace files).

3 Set the trace view as wished.

For OTDR traces

– if the function is set to the Trace mode (Trace is selected on the 
menu key Trace/Table/Summary), the JPG/PNG/PDF file will 
contain the header and the trace (in one page).

– If the function is set to Table mode (Table is selected on the menu 
key Trace/Table/Summary), the JPG/PNG/PDF file will contain the 
header, the trace and the entire results table (several pages may be 
required)

– If the function is set to Summary mode (Summary is selected on 
the menu key Trace/Table/Summary), the JPG/PNG/PDF file will 
contain the header and the summary page, with either the Bend 
table or the Alarm Table according to the selected item with the 
menu key.

This view is only available with OTDR traces.

4 Press simultaneously the left and right arrow keys  for about 5 
seconds

or

Click on the upper banner of the screen and, in the virtual control 
buttons bar, press Export key

The icon  displays until the end of process.

5 Press the FILE key to find the JPG, PNG or PDF file in the Explorer

The files are saved in the directory Print, on the disk media storage.
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Name of the report
If a trace has been saved in a report file, the name of the JPG/PNG/PDF 
file is as follow:

• name of the stored trace_date (year/month/day)_time (hour/minute/
second).jpg/png/pdf

Merging pdf or txt files
In the Explorer page, two pdf/txt files or more, generated via the results 
traces can be merged in one pdf file.

NOTE

If several traces are displayed in overlay, a different report 
file is generated for each trace open.

Figure 51 Example of report (in pdf)
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• The pdf files that can be merged are those generated via the Fast 
Report key on trace results page or via the Export key on the upper 
banner (or left and right arrow keys) (see “Creating a report” on 
page 103)

• The txt files that can be merged are those saved with the results 
trace (see OTDR Modules User Manual: E2100M02).

1 In the Explorer, select the two or more pdf/txt files generated

2 Press Export menu key

3 Press Merge key

The icon  is displayed during merging process.

After a few seconds, the files are merged in one pdf/txt file, which name by 
default is: merged_year_month_date__hour_min_sec.pdf 

The file is automatically saved in the same directory as the one where files 
have been selected.

It gathers all results from pdf/txt files selected (and traces for pdf file), in one 
single pdf file of several pages (1 results screen per page, if the results 
table does not exceed one page).

Figure 52 Files selection and Merge key
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Storage media
For saving or recalling data, the 2000 Platform offers a wide choice of 
media, both built-in and external.

Free space on selected media is clearly displayed at the bottom of the left 
panel.

Storage media built into the 2000 Platform
The 2000 Platform is delivered with an internal memory, which maximum 
capacity is of 1GB (with a minimum of about 128 Mb are available for data 
storage).

External USB storage media
The 2000 Platform is equipped with 2 USB ports as standard. One of these 
can be used to connect an external storage medium, in particular a USB 
memory stick.

NOTE

Once merged file is saved, it can be renamed in the 
Explorer (see “Renaming a directory / file” on page 89).

NOTE

Although two USB ports are present, it is not possible to 
use simultaneously more than one external USB storage 
medium. 
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USB memory stick connection
1 Insert the USB memory stick in one of the 2000 Platform's USB port. 

A sound is emitted to confirm the successful insertion and recognition 
of a USB memory stick.

Then, the icon  is displayed in the upper banner to inform the 
user the USB stick is ready to be used.

USB memory stick disconnection
1 Before disconnecting the USB memory stick, always select a storage 

device different from usbflash (select disk for example) in the 
explorer. 

2 Make sure you no longer have any running applications using the 
usbflash storage media.

3 The user must push the EJECT USB key, available in File Explorer.

The icon becomes  to indicate it can be removed safely. In this 
state, the USB stick cannot be used anymore

The USB memory stick can then be disconnected from the Platform USB 
port.

See Chapter 16 “Maintenance and Troubleshooting” if any problem occurs 
with the USB memory stick

When a file is moved in the explorer of the Platform, 
the end of the move on the screen does not mean that 
writing of data into the memory is complete. Some data 
may still be in a writing process if the storage unit is 
removed prematurely. 

NOTE

The USB memory stick can also be removed using the 
Expert Tools > Media Utilities menu, accessible via the 
System Settings page.
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Cloud Storage

Principle and prerequisites of the Cloud Storage

The Cloud storage defined the outsourcing of data on distant servers, 
which avoid the data storage on a local workstation.

The cloud storage onto a 2000 Platform allows to transfer the files from the 
Platform toward a distant server and vice-versa.

Before configuring the Cloud Storage on Platform, you must first create an 
account on a Cloud Platform on internet. 

The Cloud storage function onto the 2000 Platform works exclusively with 
sites using the WebDav technology such as CloudSafe (https://
secure.cloudsafe.com/pages/index.html) or Box (https://www.box.com/
pricing/).

Once account is created, with WevDav configuration, you get the following 
information for connection:

– URL 

– Login Name

– Login Password

Configuring and connecting to Cloud Storage on the 
2000 Platform

Configuring the 2000 Platform

Once an account has been created on the Cloud site, configure the 2000 
Platform before establishing the connection:

https://www.box.com/pricing/
https://www.box.com/pricing/
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1 On the Home page, press Settings to reach the System Settings 
page

2 In the I/O Interfaces windows, press Cloud Storage parameter

A new menu opens

3 In the Url parameter, enter the URL define for the Cloud server 
created on internet

4 In the User parameter, enter your Login created on your account

5 In the Key / Password, enter the password attributed by the Cloud 
server.

Connecting Cloud Storage

Once configuration has been established on the 2000 Platform, it is ready 
to be connected with Cloud server:

Select one parameter of the Cloud Storage window on 2000 Platform

Before configuring the Cloud Storage, make sure the 
configuration for Ethernet parameters and Proxy 
parameters are correctly configured. See “Ethernet > 
Mode” on page 67 and “Proxy > Use proxy” on 
page 68.

Figure 53 Example of configuration

Configuration on Cloud server 
(example with CloudSafe)

Configuration on 2000 Platform
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1 Press Connect Cloud Storage menu key .

The connection launches

2 Once connection is established, a message displays in the window

3 Press any key to continue, and start files transfer.

The icon  is displayed on the upper banner as long as the connection 
is active.

Disconnecting from Cloud storage

To disconnect the 2000 Platform from Cloud storage:

1 Press HOME hard key.

2 Select a parameter of the Cloud Storage window.

3 Press Disconnect Cloud Storage menu key.

Transferring files using Cloud Storage

Once connection between 2000 Platform and cloud storage server is 
successfully established, the files can be transferred from one Platform to 
the other.

1 Press HOME hard key.

2 Press FILE Explorer on the Home page

In the Explorer page, a new storage media is available: cloud-
storage.
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3 Transfer the files from the disk or USB memory stick of the 2000 Plat-
form toward the cloud storage or vice-versa:

a Select the file(s) to be transferred

b Press the Edit > Copy or Cut menu keys

c Select the storage media (and the directory) into which files 
must be copied.

d Press Paste menu key

The cloud-storage media is not available when File 
Explorer is opened from a FO application.

Figure 54 File Explorer with cloud storage

The cloud storage is automatically disconnected once 
the Platform is switched off. Reconnect from the Sys-
tem Settings page of the 2000 Platform after the Plat-
form restart.

Edition 
menu
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Abbreviations for storage media
The abbreviations used in the explorer for the different storage media are:

Abbreviation Storage medium

disk Internal flash memory

usbflash USB memory stick

bluetooth-inbox Bluetooth storage media (option)a

a. The files stored in bluetooth-inbox are lost when the Platform is switched off.

cloud-storage Cloud storage media available on PC
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Chapter 11Smart Access Anywhere

The 2000 Platform can be accessible to any network test locations, using 
a specific function: Smart Access Anywhere. 

This function allows one distant user, on a PC, to transfer the Platform 
Interface and work on TBERD/MTS-2000 or to access the internal memory 
/ USB memory stick contents on the PC and perform files transfer from T-
BERD/MTS to PC and vice-versa.

This feature does not need any licence code if the user wants assistance 
from a Viavi person located within the Viavi network.

This feature requires a licence code into the unit if the user wants any other 
assistance/support (“company A” willing to be remotely controlled by 
“company A or B”).

The Licence 2 (reference SAA-2K-L2) is used for SmartAccessAnywhere 
using Ethernet, wifi hostpot connection, or USB / Wifi connection through 
3G smartphone

• "Connection modes" page 116

• "Pre-requisite for using the Smart Access Anywhere Application" 
page 118

• "Downloading the Viavi application on PC" page 119

• "Launching the SmartAccess Anywhere application" page 121

• "Using Remote screen and File Transfer applications" page 123

• "Connection information and settings" page 129
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Connection modes
Different kinds of connection are available to access to a distant T-BERD/
MTS-2000.

According to the connection type used, specific requirements are manda-
tory.

Ethernet or WIFI connection
1 Using the Ethernet connection, no specific requirement is needed. 

The T-BERD/MTS-2000 is directly connected to Internet via an 
Ethernet Cable.

2 The WIFI connection can be used to access to MTS/T-BERD from 
any location.

This connection is available exclusively if the WIFI option is 
installed onto the T-BERD/MTS-2000 which will be seen remotely.

Figure 55 Ethernet connection
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USB/WIFI connection through 3G Smartphone  
To access to a T-BERD/MTS remotely, the connection between the unit 
and the Viavi application can be established via a USB cable or WIFI, and 
through a 3G Smartphone, having Internet Sharing capability via USB or 
WIFI.

1 To establish connection between T-BERD/MTS 2000 and Smart-
phone using USB, connect the USB cable on T-BERD/MTS-2000 
and on 3G Smartphone connector.

Figure 56 WIFI connection

Figure 57 USB connection through 3G Smartphone
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2 To establish connection between T-BERD/MTS 2000 and 3G Smart-
phone using WIFI, the WIFI option must be installed onto the T-
BERD/MTS-2000.

Pre-requisite for using the Smart Access 
Anywhere Application

To access to a T-BERD/MTS-2000 from any locations, specific require-
ments are mandatory:

• a licence installed on T-BERD/MTS-2000 which will be accessible 
from any locations.

• an Ethernet connection (the Platform must have an IP address - see 
“Ethernet > Mode” on page 67) and, if the network uses a proxy, this 
proxy must be configured (see “Proxy > Use proxy” on page 68).

• the Viavi application, delivered on a USB memory stick or down-
loaded for free at the address «xxxxx».

• port 22 (SSH) or 443 (HTTS) output opened

Figure 58 WIFI connection through 3G Smartphone

The smartphone which have been fully qualified are 
HTC Desire  and Samsung Galaxy Ace models.
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• according to connection mode selected:

– the WIFI option installed on T-BERD/MTS-2000

– a USB cable to connect T-BERD/MTS-2000 with 3G Smartphone

– a 3G Smartphone from given list and having appropriate basic 
subscription for internet connection sharing

Downloading the Viavi application on PC
The Viavi application Smart Access Anywhere must be downloaded on 
the PC which will be connected to the T-BERD/MTS-2000 remotely.

1 On PC, open an internet explorer and type the following address: 
http://smartaccess.updatemyunit.net

2 Click on the link SmartAccessAnywhere_Vxx.xx.xx.zip 

3 Select Save in the dialog box.

4 Open the directory into which has been save the zip file and unzip 
files into a directory

5 Open the directory and double click on SmartAccessAnywhere.exe 

The Smart Access Anywhere application opens:

NOTE

It is not necessary to have administrator privileges to install 
the Viavi application on PC. This application is just saved 
on PC.
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If the software version is not the last one available, a message displays, on 
the upper part of the screen to indicate the latest version available can be 
downloaded at the address: http://smartaccess.updatemyunit.net.

Figure 59 Smart Access Anywhere: Connection page

Enter Access Code
(see step 1 on page 122)

Figure 60 Warning message of a new version available
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Launching the SmartAccess Anywhere 
application

Once connection is configured, the SmartAccess Anywhere application 
can be launched

On T-BERD/MTS-2000
1 On the Home page, select the SmartAccess icon 

As soon as the icon is selected, the T-BERD/MTS-2000 begin to 
connect to SmartAccessAnywhere Server.

2 Once connection is established with the server, the T-BERD/MTS-
2000 displays a message with the code to be used to access to the 
equipment remotely.

Figure 61 Connection to SmartAccessAnywhere Server in progress
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3 Note this access code and transfer it to the distant user, who will 
access the unit remotely.

4 Press OK to hide the message.

On the distant PC
1 On the PC of the distant user, once the application is launched, enter 

the Access Number on the upper part of the screen.

2 Click on Connect to validate 

The following screen displays:

Figure 62 Access code displayed
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Using Remote screen and File Transfer 
applications

Once the Introduction page is displayed, the user can work on distant T-
BERD/MTS-2000:

• transfer the interface to work on the unit (perform acquisition, 
configure the equipment...)

• transfer files from the equipment toward the PC, and vice-versa.

Transferring the interface onto the PC
To display the remote T-BERD/MTS-2000 onto the PC:

1 On the Introduction page, click on  

or

Figure 63 Smart Access Anywhere: Home page

Information on 
connection

After remote upgrade or reboot, please wait for more 
than 2 minutes before re-starting the link between the 
PC and the unit with SmartAccessAnywhere.
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On the left menu, click on 

2 Click on Start Remote Screen! button 

The current screen of the T-BERD/MTS-2000 displays:

The VNC icon  on the upper banner of the unit indicates the 
remote screen is active.

3 Click on the upper banner of the T-BERD/MTS-2000 screen to 
access to the virtual control buttons bar, which allows to emulate hard 
keys.

You may click on any of these buttons to obtain exactly the same 
results than using the hard keys on the front panel of the 2000 Plat-
form.

4 You can use keyboard mouse of the PC to control the 2000 Platform.

Equivalence between the keyboard and 2000 Platform

The PC keyboard can replaced all the buttons and keys of the 2000 Plat-
form except the ON/OFF button: 

Figure 64 Smart Access Anywhere: Remote screen
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• The menu keys to the right of the screen are replaced by the function 
keys F1 to F6.

• The buttons below the screen are equivalent to Ctrl + a letter (see 
table below).

• The direction keys have the same function on the external keyboard 
and on the 2000 Platform.

Transferring files
To work on files (onto PC and onto unit):

1 On the Introduction page, click on .

or

On the left menu, click on .

2 Click on Start Transfer Tool! button 

Function on the 2000 Platform External keyboard 

HOME Ctrl + H

SYSTEM SETTINGS F12

SET-UP Ctrl + U

FILE Ctrl + F

RESULTS Ctrl + R

START/STOP Ctrl + S

EXPORT Ctrl + Pa

a. The Export function is available directly on the 2000 Platform pushing simultaneously 
the left and right arrow keys.

←  ↑  →  ↓

Menu keys 1 to 6 (from top to bottom) F1 → F6

ABOUT F11

Save and quit (Exit) Enter

Quit without saving (Abort) Escape
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The file Explorer on PC and the one of the 2000 Platform displays:

3 Double-click on one directory/storage media to display the contents 
(directories / sub-directories / files)

Navigation buttons

 

Figure 65 File Transfer page

PC
Directories and files

T-BERD/MTS-2000
Storage media available

Return to the Home directory

Select the PC drive in the list

Access to parent directory

click
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Transferring files from PC to T-BERD/MTS
1 On the T-BERD/MTS explorer, select the storage media, and if 

wished the (sub-)directory into which file will be transferred.

2 On the PC file explorer, select the file to be transferred

3 Click on the button Upload .

At the bottom of the screen, a new banner displays with information 
on file transfer:

Once transfer is completed, the banner disappears and the transferred file 
is underlined in blue on T-BERD/MTS explorer.

Transferring files from T-BERD/MTS-2000 to PC
1 On the PC explorer, select the storage media, and if wished the (sub-

)directory into which file will be transferred.

2 On the file explorer of the T-BERD/MTS, select the file to be trans-
ferred.

3 Click on the button Download .

A dialog box open, allowing to modify the location on PC of the file.

4 Select the directory into which file will be saved.

Figure 66 Information on file transfer

Only one file can be uploaded from PC to Platform at 
the same time.

1
2
3
4

1: location of the uploaded file on PC 3: level of transferred data

2: location of the file on T-BERD/MTS 
once transfer is completed

4: bar graph of the transfer in 
progress
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5 Press Save to start the transfer

Under both file explorers, a new banner displays with information on 
file transfer (see Figure 66 on page 127).

Once transfer is completed, the banner disappears and the transferred file 
is underlined in blue on PC explorer.

Working with files and directories on T-BERD/
MTS-2000

Renaming file or directory

1 Select a file/directory stored on the T-BERD/MTS-2000 hard disk or 
USB key.

2 Click on .

3 In the new dialog box opened, enter a new name
for the file/directory, keeping the file extension.

4 Press OK to validate.

Deleting file

1 Select a file stored on the T-BERD/MTS-2000 hard disk or USB key.

2 Click on .

3 In the new dialog box opened, press Yes to
confirm the deletion (or No to keep the file).

Creating a new directory

1 Select the storage and, if wished, the directory into which the new 
directory will be stored.
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2 Click on .

3 In the new dialog box opened, enter a name for
the new directory (newdir is given by default).

4 Press OK to validate.

The new directory is automatically created at the
location selected.

Connection information and settings

Displaying session information
At any time during application use, the information about the session in 
progress can be displayed.

1 Press Session menu key on left of the screen .

A screen as the following one displays:

This page gives information on connection «in real time».

Figure 67 Session page
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Modifying connection settings 
To modify the settings for connection to internet:

1 Press Session menu key on left of the screen  .

2 Disconnect from application pressing  

3 On the session screen (see Figure 67 on page 129), press button 
.

The following screen displays:

By default, the connection is defined to Smart-guess (default).

4 To modify the current parameters, select Forced settings.

The parameters for Port configurations turn automatically active.

5 Modify, if necessary, the port used: Default port (22) is selected by 
default

6 Select Alternative port (443) if necessary

7 If the parameter Alternative port (443) is selected, you can defined if 
the proxy is used or not in the following parameter.

Figure 68 Connection settings
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The Internet proxy configuration is available exclusively if the port 
selected is Alternative port (443) and if the Proxy is selected..

8 Once configuration is completed, press .

The Home page displays (see Figure 63 on page 123).

Testing connection
Before entering the Access code to activate the application, the connection 
to internet can be tested from displayed screen.

1 Open the Smart Access Anywhere application on PC

2 Press  button

The test is automatically launched

3 Press  to display logs in real time

Once completed, the results for connection display:

It is recommended to configure parameters of connec-
tion with your local network administrator, if the default 
parameters need to be modified.

Figure 69 Test results
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The screen displays, in two different tables:

• the Upload and Download speed (in Kbyte/s) from Device to server.

• the Latency between Device and server (in ms).

1 Press  to delete the current table, and retest connection if 
wished.

2 If connection is valid, enter the access code and establish connection 
(see “Launching the SmartAccess Anywhere application” - “On the 
distant PC” on page 122).
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Chapter 12WIFI Option

The WIFI application is available on option with the 2000 Platform, ref 
E20WIFI.

The topics discussed in this chapter are as follows:

• "Installation of the WIFI option in the Platform" page 134

• "Connection to SSID" page 137

• "Configuring the WIFI mode to which the Platform is connected" page 
137

• "Transferring the 2000 Platform interface via WIFI on a PC" page 139

• "Transferring files to/from a PC via WIFI" page 140
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Installation of the WIFI option in the 
Platform

The WIFI option is delivered on a USB key to be connected to the WIFI 
board which will be inserted into the 2000 Platform.

To install the WIFI option onto the Platform:

1 Switch off the 2000 Platform and, if necessary, unplug it from mains.

2 Remove the cover on the underside of the Platform, unscrewing the 
two screws.

If the board is already set into the Platform, follow instructions on 
step 4.

3 Insert the board, pressing it gently but firmly, taking care to the 
connectors.

4 Insert the WIFI USB key into the connector of the board.

Figure 70 View board and connectors
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5 Screw back the cover onto the Platform

6 Restart the 2000 Platform, pressing ON button.

On the Home page, a new icon is displayed .

7 Press the key to display the WIFI Setup screen.

Configuring the WIFI access
Once the Setup screen is displayed, configure the WIFI connection:

1 In the Configuration box, check the parameter 802.11 is set to 
Enable.

Figure 71 WIFI USB set into the Platform

Figure 72 WIFI Setup screen
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If the parameter is defined to Disable, the WIFI application is deacti-
vated, and the icon  is no more displayed on the upper banner.

2 Press Scan SSID menu key to scan for Service Set Identifiers 
(SSIDs) in the area.

3 Wait for the list of SSIDs to be displayed.

4 Select the desired network to connect to.

5 Press Select menu key to validated the connection.

The display goes back to Setup screen.

The SSID parameter is automatically configured with the one 
selected.

6 In Encryption parameter, select the type of encryption wished: 
None, WEP Static, WPA Personal, WPA Enterprise.

7 According to encryption type selected, enter Login (if any needed) 
and Key/Password.

Figure 73 List of SSIDs found
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8 In the AutoConnect parameter, select if the connection to SSID 
selected must be done automatically (On) or not (Off).

Connection to SSID
Once configuration is valid, connect the 2000 Platform to the Wireless 
network:

1 In the Setup screen, press Connect SSID menu key.

or

If AutoConnect is defined to On, the connection is launched auto-
matically.

Once association of Platform with SSID is established, the icon    
becomes  to indicate the connection is active.

Configuring the WIFI mode to which the 
Platform is connected

To work on WIFI with the Platform, configure the 802.11 or 802.11 IPV6 
parameters on the Setup screen.

1 If 802.11 box is chosen, select the mode of connection: 

Config 1 to 4 static mode enabling input of the configuration of 4
sites. If this parameter is selected, the following
parameters must be entered:

– Site Name the user can enter the name of the site in the Edit 
menu.

NOTE

Login and Password are kept in memory, even if the WIFI is 
deactivated or the 2000 Platform switch off and restarted.e
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– IP Address IP address of the 2000 Platform

– IP Mask address of the mask of the sub-network

– IP Gateway IP address of the machine enabling access outside the 
sub-network.

– DNS (Domain Name Server) IP address of the machine 
providing the IP address on the basis of the name

– Domain namename of the local network to which the 2000 Platform 
is connected.

Dynamic in this mode, which requires a DHCP server, the 2000
Platform requests an IP address from this server
which will be allocated dynamically if dynamic host
configuration is activated on the local network.
After selecting this mode or after power-on, the 2000
Platform tries to establish a connection to obtain an
address from a DHCP server. If for any reason, this
process fails, the 2000 Platform reverses to static IP
address mode with User1 IP address.

Note the IP address of the Platform, to be able to remote screen on PC or 
to transfer files.

Figure 74 WIFI connection in Dynamic mode

Note IP 
Address
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Transferring the 2000 Platform interface via 
WIFI on a PC

Once the IP address is displayed in the configuration screen.

1 On the PC connected to WIFI with the Platform, open Internet 
Explorer.

2 Considering 10.33.16.229 is the IP Address of the 2000 Platform 
(as shown Figure 74 on page 138), enter the following address in the 
Internet Explorer window:

http://10.33.16.229:5800
3 Press Enter to validate.

The screen of the 2000 Platform appears offset on your PC.

Figure 75 VNC window

Click to install 
TightVNC software on 
your PC (not manda-
tory) 
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See “Virtual control buttons bar” on page 70 and “Equivalence between the 
keyboard and 2000 Platform” on page 71 to get information on the 
deported screen use.

Transferring files to/from a PC via WIFI
Once connection is established between the Platform and the PC:

1 On the PC, use an FTP client, and access to internal memory via an 
internet explorer (I.E, Mozilla Firefox...) or Windows Explorer.

2 In the address bar, type the following address (10.33.16.229 being 
the IP address of the 2000 Platform defined when the connection 
was configured):

ftp://mts2000:Viavi@10.33.16.229/disk/
This allows to access to internal memory.

ftp://mts2000:Viavi@10.33.16.229/usbflash/
This allows to access to the contents of the USB memory stick 
connected to the 2000 Platform.

3 If an identification is required, enter:

– User name: mts2000

– Password: Viavi

The PC then displays the contents of the internal memory or of the 
USB memory stick from the 2000 Platform.

If you use Internet Explorer 7, the following address must 
be entered:

ftp://mts2000:Viavi@10.33.16.229/acterna/
user/disk or ftp://mts2000:Viavi@10.33.16.229/
acterna/user/usbflash
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1 If internal memory of the Platform is accessible via Internet Explorer 
(or any other explorer), right click on one file and click on Save target 
as... to transfer file onto the PC.

If internal memory of the Platform is accessible via Windows 
Explorer, select one / several files and click on Copy, then click on 
Paste on PC to transfer file.

Figure 76 Internal memory of the 2000 Platform

Internal memory open via Internet Internal memory open via Windows 
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Chapter 13Bluetooth option

The Bluetooth interface allows interface and file transfers. 

It is an option that must be installed at the factory.

The topics discussed in this chapter are as follows:

• "Setting up a Bluetooth connection" on page 144

• "Transferring files via Bluetooth" on page 148

• "Transferring the Platform interface on a laptop PC via Bluetooth" on 
page 150

• "Removing the Pairing" on page 152

The product is approved in accordance to R&TTE 
directive concerning transmitter module marked by 
CE0678. It is manufactured by MITSUMI and it is an 
OEM product.

This device complies with Part 15 of the FCC Rules. 
Operation is subject to the following two conditions: 
(1) this device may not cause harmful interference, and 
(2) this device must accept any interference received, 
including interference that may cause undesired oper-
ation. This device contains FCC-ID: POOWML-C40.
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Setting up a Bluetooth connection

Installing the Bluetooth option onto the 2000 
Platform

The Bluetooth option is delivered on a USB dongle to be connected to the 
board which will be inserted into the 2000 Platform.

To install the Bluetooth option onto the Platform:

1 Switch off the 2000 Platform and, if necessary, unplug it from mains.

2 Remove the cover on the underside of the Platform, unscrewing the 
two screws.

If the board is already set into the Platform, follow instructions on 
step 4.

3 Insert the board, pressing it gently but firmly, taking care to the 
connectors.

4 Insert the Bluetooth into the connector of the board.

Figure 77 View board and connectors
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5 Screw back the cover onto the Platform

6 Restart the 2000 Platform, pressing ON button.

The Bluetooth option can be launched.

Pairing the Platform with a device
1 On the Home page, press System Settings key

2 Under I/O interfaces, select Bluetooth > Enable

The icon  is displayed on the upper banner of the screen

3 Push the Bluetooth Pairing key 

The Paired Bluetooth screen appears

4 Press the Become Pairable soft key to wait for another device to 
initiate the connection to the 2000 Platform.

A screen as the following one displays:

Figure 78 Bluetooth set into the Platform
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5 Activate Bluetooth on the equipment which need to be paired with the 
Platform

6 If you are asked to, enter a pairing code on the equipment.

7 In this case, once the pairing code is validated on the equipment, 
enter the same pairing code on the Platform to validate the connec-
tion:

8 Press Enter to validate.

Figure 79 Waiting for pairing

Figure 80 Enter Pairing code
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Both equipment are now paired:

The icon has a blue background when paired with a device , 
versus no background when not paired .

Searching new devices to be paired with the Platform

1 If the desired device is not displayed on the screen, or if no devices 
are detected, press the Search Devices soft key.

The 2000 Platform is searching for the devices which could be used 
via Bluetooth with the equipment.

A baragraph is displayed during research  

Once the research is completed, a list of the available devices is 
displayed, with the level of detection of the 2000 Platform 

Figure 81 Platform paired with one equipment

REMINDER

You may need to activate bluetooth on the other device 
to allow pairing.
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a Select the device to be paired with the Platform

It will be underlined in blue

b Push the Pair key to connect the device to the Platform

2 If prompted, enter a pairing code. The code must be identical on the 
2000 and the device.

3 Once the bluetooth device and the Platform are paired, a screen is 
displayed with the description of the device (see Figure 81 on 
page 147).

The icon has a blue background when paired with a device , 
versus no background when not paired .

You can now go to the file explorer and transfer files from the 2000 Platform 
toward the bluetooth device and vice versa (see “Transferring files via Blue-
tooth” on page 148) or transfer the Platform interface on VNC via Bluetooth 
(see “Transferring the Platform interface on a laptop PC via Bluetooth” on 
page 150).

Transferring files via Bluetooth
Once the connection has been established with a bluetooth device:

Figure 82 List of devices found
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1 On the Home page, press File Explorer key to go in the File 
Explorer.

2 Select the file(s) to be transferred from the Platform toward the PC.

3 Push Export > Send by Bluetooth menu keys .

A confirmation message displays once the transfer is completed.

You can also transfer file(s) from the bluetooth device toward the Platform.

In this case, the files received will be stored in a storage media created 
automatically on the Platform: bluetooth-inbox.

Figure 83 Confirmation of files sending
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Transferring the Platform interface on a 
laptop PC via Bluetooth

If the 2000 Platform is paired with a laptop equipped with Bluetooth, the 
interface can be transferred on this PC in order to work on the unit from the 
laptop PC.

To remote the screen

1 Install the Viavi Remote Operation application on the laptop PC:

a Download the application

b Double click to launch it and follow the instruction for installation

Figure 84 Confirmation of file receiving

WARNING

The files stored in bluetooth-inbox will be lost once the 
2000 Platform is switched off. Copy/Paste the files to 
keep toward another storage media (disk, usb key...).
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The application is available on PC, in Start > All Programs > Viavi > 
Remote Operation.

2 Pair the 2000 Platform with laptop PC via Bluetooth (see “Setting up 
a Bluetooth connection” on page 144).

3 Once pairing is active, open the Remote Operation application on 
laptop PC.

A new window opens, and scanning is automatically launched to find 
the equipment paired with laptop PC.

4 Once scanning is completed, the 2000 Platform displays the list of 
detected equipment.

5 Click on View Unit button to remote the screen on PC.

The current screen of the 2000 Platform displays on a new window 
on the PC.

In the small window next to VNC window (see Figure 85 on 
page 151), the button View Unit becomes Stop Viewing.

Figure 85 2000 Platform detected via Bluetooth on PC

Launch a new Scan 
to detect new unit(s)
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See “Virtual control buttons bar” on page 70 and “Equivalence between the 
keyboard and 2000 Platform” on page 71 to get information on use of PC 
to work on 2000 Platform.

Closing the remote screen and the application

To stop using the remote screen on PC:

1 In the small window available with the VNC window (see Figure 86 
on page 152) click on Stop Viewing button.

The VNC window closes.

At any time, the remote screen can be displayed back clicking on 
View Unit button.

2 To close the application, click on File > Exit in the window.

Removing the Pairing
1 To remove the pairing between the two equipments, in the System 

Settings page, push the Bluetooth Pairing key

Figure 86 Remote screen on PC
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2 In the screen displayed, push the Remove pairing key

The icon on the upper banner of the screen becomes  showing the Plat-
form is no more connected to a bluetooth device, but the Bluetooth option 
is still active.

To deactivate the bluetooth onto the Platform, go in the System Settings 
page, and under I/O Interfaces, select Disable on the Bluetooth param-
eter.
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Chapter 14Technical specifications

This chapter contains the technical specifications of the 2000 Platform 
mainframe.

The topics discussed in this chapter are as follows:

• “Display specifications” on page 156

• “Memory” on page 156

• “Input/Output” on page 156

• “Power supply” on page 156

• “Dimensions - Weight” on page 158

• “Environment” on page 158

• “Characteristics of the options” on page 160
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Display specifications

Screen
• Backlight hgh visibility color touchscreen

• Size: 5 inches 

• Resolution: 800 x 480 pixels

Memory
• Standard memory: internal memory, with a capacity of 1GB (with a 

minimum of about 125 Mb are available for data storage).

Input/Output
• two USB 2.0 host ports.

• one Mini USB 2.0 device

• one RJ 45 connector for Ethernet interface 10/100/1G

• built-in loudspeaker + headset jack

Power supply

Battery
The instrument can be supplied with one Li-Polymer battery.
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Endurance of the 2000 Platform with battery

Measurement conditions:

– at +25 °C, 

– at full battery capacity (4.5 Ah), 

– 2000 Platform equipped with one OTDR LM module

Endurance

Mains adapters

Supply or Power assigned in AC and in DC: 25 W

Endurance

Conditions of use
Li-Polymer 
battery

According to Telcordia GR-196-CORE recommenda-
tion:
Normal conditions, with normal backlight, 3 acquisi-
tion of 30 seconds per quarter of hour, auto off

up to 8 hours

Under continuous acquisition, with high screen back-
light:
- with an OTDR QUAD Module
- with an OTDR LM Module

Up to 3h
Up to 3h45

Standard Mains Adapter

Input 100-240 V, 50-60 Hz

Output 12V DC 2.5 A max

Compliance EN 60950
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Dimensions - Weight

Environment

Temperature

Weight

2000 Platform without options, battery nor module 692 g 1.52 lbs

2000 Platform with a Li-Polymer battery and one 
OTDR LM Module

1.21 kg 2.67 lbs

Li-Polymer battery 172 g 0.37 lbs

VFL/PWM option 30 g 0.066 lbs

Dimensions (mm)
(H X W X D)
Bumpers included

Dimensions (mm)
(H X W X D)
W/o bumpers

Without module 175 x 138 x 41 169 x 134 x 39

With 1 module 175 x 138 x 80 169 x 134 x 72

• Operating temperature range -20°C to +50°C (-4°F to +122°F)

• Operation including all options 
(guaranteed specifications)

0° to +40°C (+32°F to +104°F)

• Storage -20°C to +60°C (-4°F to +140°F)



Chapter 14 Technical specifications
Environment

User Manual 79000000203 Rev. 005 159

Humidity
• 5 to 95% without condensation

EMI/ESD
• CE class B Compliant (EN61326-1)

• FCC 47-1 Part 15 Compliant

Drop test
In accordance with the Telcordia GR-196-CORE recommendations, the 
2000 Platform resists the following test: 

• 6 impacts dropped from a height of 1m on a pinwood floor of 5 cm 
thickness (1 impact on each of its 6 sides, with power off).

Shocks
The 2000 Platform resists the following test:

• 3 shocks per axis along each of the 3 axes, with power off.

• Impacts of 15g, 1/2 sine, duration 11 ms, at 10 second intervals.

Bumps
The 2000 Platform resists the following test: 

• 1,000 bumps per axis along each of the 3 axes, with power off.

• Jolts of 15g, 1/2 sine, duration 6 ms, at 1 second intervals.

Vibration
The 2000 Platform resists the following vibration tests:
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• Complete test comprising 6 cycles along each of the x, y and z axes.

• One cycle of 5 to 200 Hz and back to 5 Hz with a sweep duration of 
one minute/octave.

• 3 mm amplitude displacement test, for the range 5 Hz to 15 Hz.

• 3g acceleration test for the range 16 Hz to 200 Hz.

Flammability
The 2000 Platform housing (in ABS, type V0) does not propagate fire.

Characteristics of the options

Power meter
Specifications given for 25°C, after 20 minutes stabilization time and after 
zero setting.

• Wavelength range: 800 to 1650 nm in steps of 1 nm

• Calibrated wavelengths: 850 / 1310 / 1490 / 1550 / 1625 / 1650 nm1

• Accuracy at calibrated wavelengths: ± 0.2 dB (at -30 dBm)

• Input power range: -60 dBm to +10 dBm

• Maximum resolution: 0.01 dB / 0.01nW

• Measurement range:+5 to -50 dBm (+5 to -45 dBm from 800 to 1250 
nm)

• Linearity within the measurement range: ± 0.2 dB

1.Specifications guaranteed to the calibrated wavelengths, except for 1650 nm
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High power Power meter
Specifications given for 25°C, after 20 minutes stabilization time and after 
zero setting.

• Wavelength range: 800 to 1650 nm in steps of 1 nm

• Calibrated wavelengths: 850 / 1310 / 1550 nm

• Accuracy at calibrated wavelengths: ± 0.25 dB (at -15 dBm)

• Input power range : +30 dBm to -40 dBm

• Measurement range:+27 to -30 dBm

• Linearity within the measurement range: ± 0.25 dB

Talkset
• Dynamic range: typically 32 dB at 25°C with a FC adapter (use a FC/

PC connection exclusively).

• Laser, typical wavelength 1625 nm, class 1 (EN60825 and FDA21 
CFR Part 1040.10 standards)

VFL
• Wavelength: 650 nm

• Length of fiber: up to 5 km

• Class 2 laser (standards EN60825-1 and FDA21 CFR Part 1040.10).

Bluetooth and WIFI
• WIFI: standard IEEE802.11n

• Bluetooth Option

– Class 2

– Range: up to 20 meters

– Bluetooth V2.1 + EDR
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Chapter 15Options and accessories

This chapter shows the references of the options and accessories of the 
2000 Platform.

The topics discussed in this chapter are as follows:

• “References of options for the 2000 Platform” on page 164

• “References of accessories” on page 165

• “References of manuals” on page 166

• “References of result processing software” on page 166
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References of options for the 2000 
Platform2

2.These options must be ordered together with the instrument.

Base Unit references Reference

MTS-2000 Handheld Platform with touchscreen EM2000T

T-BERD 2000 Handheld Platform with touchscreen ETB2000T

Power Meter / VFL / Talkset options Reference

Optical Power Meter option for 2000 Platform E20PM

High Power Power meter for 2000 Platform E20HPPM

Power Meter and VFL option for 2000 Platform E20PMVFL

Power Meter and Talkset option for 2000 Platform E20TSPM

VFL option with UPP 2.5mm connector for 2000 Platform E20VFL

WIFI / Bluetooth options Reference

WIFI option for 2000 Platform E20WIFI

Bluetooth option for 2000 Platform E20BLUE

Mains options Reference

Cigarette lighter adapter for 2000/4000 Platform
E40LIGHTE
R

Additional AC Adapter/Charger for 2000 Platform. Includes 
adaptable plugs (Europe, US, UK, Australia, Japan)

E20PWMC



Chapter 15 Options and accessories
References of accessories

User Manual 79000000203 Rev. 005 165

References of accessories

Smart Access Anywhere References

Smart Access Anywhere for 2000 Platform -L1: Remote coach-
ing and file transfer for T-BERD/MTS 2000 using Ethernet or 
WIFI HotSpot connection

SAA-2K-L1

Smart Access Anywhere for 2000 Platform -L2: Remote coach-
ing and file transfer for T-BERD/MTS 2000 using Ethernet, 
WIFI and selected 3G Smartphone (via USB or WIFI)

SAA-2K-L2

Battery Reference

Replaceable Li-Polymer battery (see “Changing the battery” on 
page 190)

E20LIPO

Scope Reference

Digital Videoscope kit including FBP-P5000 probe (USB2.0) in 
a small soft case, and 7 tips in a box (FC, SC, SC-APC, LC, 
U25M, U25MA & U12M)

EDF-
SCOPE5K

Digital Videoscope kit including FBP-P5000i probe (USB2.0) in 
a small soft case, and 7 tips in a box (FC, SC, SC-APC, LC, 
U25M, U25MA & U12M)

EDF-
SCOPE5Ki

Carrying Cases References

Hard carrying case for the MTS/T-BERD 2000 and various 
accessories

E20HCASE1

Large Soft Case for MTS/T-BERD 2000/4000 Platform E40SCASE1
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References of manuals

References of result processing software3

User manual for 2000 Platform Reference

Printed User manual for 2000 Platform (French) E2000M01

Printed User manual for 2000 Platform (English) E2000M02

Printed User manual for 2000 Platform (German) E2000M03

NOTE

The User Manuals for MTS/T-BERD 2000 (Platform & Mod-
ules) are available in pdf format, into the unit.

The printed versions of the manuals are available on 
option, in French, English and German.

3.Free software updates on the Web (but without user manual)

References

Optical Fiber Trace software EOFS100

Optical Fiber Trace software (5 licences) EOFS1005L

Optical Fiber Trace software (site licence) EOFS100SL

FiberTrace software - update EOFS100UP

Optical Fiber Cable software EOFS200

Optical Fiber Cable software (5 licences) EOFS2005L

Optical Fiber Cable software (site licence) EOFS200SL



16

User Manual 79000000203 Rev. 005 167

Chapter 16Maintenance and 

Troubleshooting

This chapter describes how to maintain your unit and identify and correct 
problems related to the 2000 Platform.

The topics discussed in this chapter are as follows:

• “Maintenance procedure” on page 168

• “Recycling Information” on page 185

• “Troubleshooting” on page 186

• “General information on warranty” on page 193



Chapter 16 Maintenance and Troubleshooting
Maintenance procedure

168 User Manual 79000000203 Rev. 005

Maintenance procedure
Maintenance work on this instrument must only be undertaken by qualified 

personnel using suitable equipment.

In most cases, it is advisable to contact the nearest Viavi Service Centre, 
which will undertake the appropriate troubleshooting and repair work.
The performance and technical complexity of the 2000 Platform class this 
instrument in a new generation of equipment, for which Viavi has laid down 
a maintenance policy based on the principle of standard module replace-
ment.
In implementation of this policy, we have set up powerful card trouble-
shooting test resources in our factories and a rapid dispatch system oper-
ating between our factories and branches.
Only by this procedure can the high quality of the instrument continue to be 
ensured after repair work. This procedure also has the advantage of 
reducing repair costs and time.

In the interests of quality and efficiency, we strongly recommend adoption 
of the following procedure in the event of a fault, before any other steps are 
taken:

• Verify that the instrument is plugged in.

• Check the connections of any peripheral equipment to the Platform.

• If a fault is detected, or in case of doubt, it is advisable to contact the 
nearest Viavi Service Centre, which will undertake the appropriate 
repair work. 

Cleaning

Cleaning plates and housings

The front and rear plates and the housings may become tarnished with 
handling. To clean them, use only a rag moistened with soapy water.
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Never use any product containing acetone, trichlorethylene, benzine or 
alcohol, as these will attack the printed markings.

Cleaning the screen

To clean the screen, use an antistatic product.

Cleaning the optical cable connector
• Use a non-fluffy type of paper, such as Joseph paper, soaked in 

isopropylic alcohol.

• Pay particular attention to the polished face of the fiber, rubbing it in a 
direction perpendicular to the axis of the fiber.

Cleaning the optical connections of the 2000 
Platform
• Squirt a highly volatile solvent (such as isopropylic alcohol) into the 

connector.

• Blow out the connector using a clean dry air supply from an aerosol 
can fitted with an extension.

Accessing to the 2000 Platform information 
On the 2000 Platform, some screens allows to display information on 
different elements of the equipment.

To display the information on the 2000 Platform

NOTE

If your module has a universal connector, unscrew its adap-
tor to access the ferule.
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1 On the Home page, validate Settings icon to reach the System 
Settings page.

2 On the right menu keys, press About to display the presentation 
screen of the 2000 Platform.

General page

The General page is displayed by default, and allows to display the presen-
tation screen, with all the information concerning the software versions, the 
hardware options and the module installed.

This page shows:

• The software version information

• The product contents: base, optical options, battery type, touch-
screen used, module installed and date of calibration for options .

The options set into the 2000 Platform are marked with a green tick.

Software options page

This page allows to visualize the software options available on the 2000 
Platform.

Figure 87 General page
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1 Once on the About screen, press Software Options menu key to 
display the list of software options available on your 2000 Platform.

Services Data page

This page allows to display information about the elements inside the 2000 
Platform (CPU, Memory, hardware revision, screen reference...).

1 Once on the About screen, press Services Data menu key to 
display the list of elements contained on your 2000 Platform.

Figure 88 Software Options page

Figure 89 Services Data page
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Accessing to the 2000 Platform documentation
All documents necessary for the 2000 Platform use are directly available 
onto the equipment.

To display the list of documents available for 2000 Platform use:

1 Validate the Help icon on the Home page.

2 In the page, click one link to display the corresponding document: 
User manual, Getting Started Manual, Quick Card...

Installing a new version of the software

Figure 90 Help page

When a new software version is loaded, there is a risk of 
re-initialization of the internal memory. Before installing the 
new software, it is therefore advisable to save the results in 
the memory, using the Save function called up by the FILE 
button.
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Downloading from Internet

When the software is obtained from the Internet, it must be saved on a 
storage medium before the software upgrade of the product can be carried 
out. To do this:

1 Open Internet Explorer

2 On the Viavi web site (http://www.viavisolutions.com), open the page of 
the product concerned

– MTS 2000 Multiple Services Test Platform

or

– T-BERD 2000 Multiple Services Test Platform 

3 Click on the tab Downloads.

4 Click on the link 2000 Firmware Update
A new page opens, displaying the current version available and 
several links.

5 According to your region, click on the one of the following icon to 
download the archive.

Do not interrupt the installation process, as this could dam-
age the instrument.

To avoid any interruption of the installation procedure, the 
2000 Platform must be operating on the mains: if the proce-
dure is started while operating on battery, a message indi-
cates that the instrument must be connected to the mains.

NOTE

You can directly enter the internet address  http://
www.updatemyunit.net, which will give access to the 
installation portals for all T-BERD/MTS from Viavi, and click 
on the link T-BERD®/MTS-2000 Platform.

http://www.viavisolutions.com
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Download from European server

Download from North American server

Download from Singapore server

6 In the new dialog box displayed, click on Save to save the exe file on 
the PC.

7 Once completed, connect the USB memory stick to the PC and follow 
the instructions chapter “Installation from a USB memory stick” on 
page 176, from step 2.

Installation from Viavi Server

The update can be performed directly onto the equipment, using the Viavi 
server.

1 Connect the 2000 Platform to a PC via an Ethernet link.

2 On the Home page, press Settings key to open the System 
Settings page.

3 In I/O Interfaces, on the line Ethernet, select Mode: Dynamic.

4 In the Upgrade Server box:

– On the line Address Type, select Viavi Server

The address 2k.updatemyunit.net is automatically displayed.

5 Select if the new release for 2000 Platform must be automatically 
detected (Enable) or not (Disable). See “Checking new upgrade on 
Viavi Server” on page 179.

Figure 91 Configuration of the Viavi Server
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6 In the I/O Interfaces box:

– On the line Use proxy, select No, Manual or Auto wether a proxy 
is used or not.

7 Press, in succession the menu keys: Expert Tools > Upgrades > 
Software Upgrade > Upgrade via Ethernet.
The message Verify IP address of PC server appears. 

8 Click on Continue.
The list of the software versions available on the PC is displayed next 
to the versions installed on the 2000 Platform.

Installation from another server

Before starting the software upgrade via Ethernet, make sure the IP 
address of the PC server.

The update can be performed directly onto the equipment, using an http 
address.

1 Connect the 2000 Platform to a PC via an Ethernet link.

Figure 92 List of software versions (current and new)

Software versions 
installed on Platform

Software versions avail-
able on selected media 
for update
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2 On the Home page, press Settings key to open the System 
Settings page.

3 In I/O Interfaces, on the line Ethernet, select Mode: Dynamic.

4 In the Upgrade Server box:

– On the line Address Type, select Server Name or IP Address.

– Enter the Server Name (if Server Name has been previously 
selected) or the Server Address (if IP Address has been previously 
selected)

5 In the I/O Interfaces box:

– On the line Use proxy, select No, Manual or Auto wether a proxy 
is used or not.

6 Press, in succession, Expert Tools > Upgrades > Software 
Upgrade > Upgrade via Ethernet.
The message Verify IP address of PC server appears. 

7 Click on Continue. 
The list of the software versions available on the PC is displayed next 
to the versions installed on the 2000 Platform (see Figure 92 on 
page 175).

Installation from a USB memory stick

You must be equipped with a USB memory stick with a minimum capacity 
of 128 Mo.

Before installing the upgrade, you must format the USB memory stick (see 
“Formatting the USB memory stick onto the 2000 Platform” on page 188).

1 Once formatted, disconnect the USB memory stick from the 2000 
Platform using the key Eject USB in the Media Utilities page.

As for any media formatting, please note that all data pres-
ent on the USB memory stick will be irremediably lost.
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2 Connect the USB memory stick to the PC

3 Unzip the upgrade files on the PC and transfer it to the USB memory 
stick:

a Download and save on your PC the.exe upgrade file that you 
can get from the web ( http://www.viavisolutions.com, see “Down-
loading from Internet” on page 173). 

b Once the transfer is completed, double click on the.exe file: A 
window will appear. Check that the folder is correct i.e. the USB 
memory stick driver is appearing in the line at the bottom of the 
dialog box then press OK. If not, click on the icon  in order to 
select the right USB drive.

c Press OK and wait for the end of loading.

4 Then remove the USB memory stick, using the appropriate proce-
dure, from your PC

5 Insert the memory stick into one of the USB ports on the Platform.

Figure 93 List of software update

NOTE

A bip is emitted each time the USB memory stick is 
inserted or removed from the USB port.

http://www.viavisolutions.com
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6 Press successively Expert Tools > Upgrades > Software Upgrade 
> Upgrade from USB.

The message Are you sure? is displayed

7 Click on Confirm. 

The list of the software versions available on the USB stick is 
displayed next to the versions installed on the 2000 Platform (see 
Figure 92 on page 175).

Launching the upgrade

Whatever is the method selected for upgrade (Server, USB key...) and 
once the list of the software versions available is displayed next to the 
versions installed on the 2000 Platform (see Figure 92 on page 175), follow 
these instructions to launch the upgrade:

1 Click on Show Prev choice or Show Next Choice to display the 
previous and next versions available.

2 Click on Confirm this Choice to start the upgrade of the selected 
software(s). 

or
Click on Confirm All Choices to upgrade all versions.

Upgrading begins. The 2000 Platform is automatically rebooted. 
Upgrading takes several minutes. Finally, the 2000 Platform is auto-
matically restarted.

NOTE

The software versions list does not always appear (cf previ-
ous versions) as well as the Previous / Next Choice but-
tons and the Confirm/Continue key. In this case, the 
upgrading starts automatically.
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Checking new upgrade on Viavi Server

If the Viavi Server is selected for upgrade (see Figure 91 on page 174), the 
parameter Check new release can be defined to automatically inform user 
of a new upgrade available for Platform.

1 In the System Settings screen, select Upgrade parameters

2 Check the Address Type is set to Viavi Server.

3 Define the parameter Check new release to Enable.

If the parameter is set to Enable, a message displays, at any time, 
when one update is available on server.

4 Press Ok to display the list of software versions available (see 
Figure 92 on page 175) and follow instructions “Launching the 
upgrade” on page 178.

During the upgrade, the Testing indicator is lit in red. 
Do not push any button or remove the USB memory 
stick while the indicator is lit. The USB stick can be 
removed if necessary once the Testing indicator is off.

Figure 94 Checking new release
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Upgrading from the boot

This method is used to make a complete reinstallation of the software 
versions.

1 Turn off the 2000 Platform using the ON/OFF button, keeping the 
equipment connected to the mains.

2 Insert the USB stick onto which the software versions are stored into 
one of the USB port of the Platform

3 Press simultaneously SETUP + START/STOP buttons

4 Maintaining the two buttons pressed, press ON button to start the 
2000 Platform.

5 A menu displays, then the screen allows to select Upgrade from 
USB

After a few seconds, a new page displays indicating that to continue 
the reboot, the validation key must be pressed.

Press the hard key  .

The reboot starts automatically.

Once the upgrade is completed, the 2000 Platform will automatically 
turns on and display the Home page.

Install Option
This page allows to import the licence to get a software option.

The Testing indicator will be lit in red during upgrade. 
Do not push any key or remove the USB memory stick 
until the lit turns off.
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To import the license, you can either enter manually the licence code, given 
in the license file, (.lic file) or import this file with a USB memory stick 
connected to the 2000 Platform.

Enter Manually the Licence
1 In the Home page, click on Expert Tools > Upgrades > Install 

Option > Enter License

The edition keypad is displayed

2 Enter the challenge code of the option, set at the bottom of the file 
(see Figure 95 on page 181),

Figure 95 Example of a License file (.lic)

It is strongly recommended to perform the installation 
using the importation of Licence via a USB memory 
stick.

Licence Code
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3 Press the Enter key to validate the code

Your software options will be installed

At the end of this sequence you will be asked to reboot the unit to 
apply the modifications, pushing the key . Confirm the reboot to 
restart the Platform.

Import the license from the USB memory stick
1 In the Home page, select the Settings icon

2 In the System Settings page, press Expert Tools > Upgrades > 
Install Option > Import License

If the USB memory stick is not already connected to the Platform, a 
message asking the memory stick insertion is displayed. Confirm it 
once the stick is connected.

Figure 96 Enter the Licence code

The license file can be opened via a word processing 
software such as Word...

The challenge code must be entered exactly as it is in 
the .lic file, paying attention to the lower-case and 
upper-case letters etc.
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3 In the File Explorer, select the USB stick, then the license file (.lic) to 
be imported,

4 Click on Load > Confirm

5 The challenge codes contained in this file will then be loaded auto-
matically and your software options will be installed.

6 At the end of this sequence you will be asked to reboot the unit to 
apply the modifications, pushing the key . 

7 Confirm the reboot 

Locking the 2000 Platform
The 2000 Platform can be locked at any time:

1 In the HOME page, click on Expert Tools

2 Click on Instrument Lock Out

3 Confirm the 2000 Platform locking by clicking on Confirm (or use the 
Cancel key to cancel the process).

The numeric keypad is displayed

4 Enter the password to lock the instrument: 42000 with the numeric 
keypad displayed.

Figure 97 License imported
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5 Click on Enter

The 2000 Platform locking screen is displayed.

Click on the Notepad Message key to add a message using the text 
edition.

Figure 98 Password

Figure 99 Locking screen
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Unlocking the 2000 Platform

1 Once the locking screen is displayed, click on the key Unlock Instru-
ment.

2 Press confirm to confirm the Platform must be unlocked.

3 Enter the password 42000 using the numeric keypad displayed and 
validate.

The screen automatically displays the HOME page.

Returning an instrument
When returning an instrument, it is essential to indicate the following 
minimum information:

• the type and serial number of the instrument (on the identification 
label) and the configuration code (under the bar code)

• a description of the fault found on the instrument.

The returned instrument will then be repaired and calibrated.

Guarantee conditions
Any repair operation supervening within the guarantee period of the instru-
ment will be carried out at the expense of Viavi. However, for any sub-
assembly upon which work has been carried out otherwise than by Viavi 
Service Centers, the cost of a replacement sub-assembly will be invoiced.

Recycling Information
Viavi recommends that customers dispose of their instruments and periph-
erals in an environmentally sound manner. Potential methods include 
reuse of parts or whole products and recycling of products components, 
and/or materials.
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Waste Electrical and electronic Equipment 
(WEEE) Directive

In the European Union, this label indicates that this product 
should not be disposed of with household waste. Il should be 
deposited at an appropriate facility to enable recovery and recy-
cling.

Troubleshooting

Interpreting alarms

Troubleshooting Solution

Nothing happens when the 
ON/OFF key is pressed.

- Make sure that the battery is present or 
charged; or the mains adapter is properly 
connected (see “Connecting the mains 
adapter” on page 17).

Nothing happens on 
screen, whatever is the 
action done (menu key or 
hard key pressed...)

- The Platform must be rebooted.
See “Resetting the 2000 Platform” on 
page 21.

Nothing happens on touch-
screen, whatever is key 
pressed (icon, menu key...)

- Perform an Autotune. See “Launching the 
«Autotune» process (for capacitive touch-
screen)” on page 192). 

You are using the 2000 
Platform in the ordinary 
way when it suddenly 
switches off.

- Check the instrument is not configured to 
Auto off. See “Defining the Automatic shut-
down of the 2000 Platform” on page 29). 
- Check the battery charge level. See 
“Charging the battery” on page 17.
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The battery refuses to 
charge (the Charge indica-
tor does not go on when the 
instrument is connected to 
the mains and is not oper-
ating).

- There is no battery in the instrument.
- The temperature level of the equipment 
does not allow the battery charging for safety 
reasons. Wait the equipment cools down.
- The battery needs to be changed.
See “Changing the battery” on page 190.

When using the touch-
screen, nothing happens

- The touchscreen needs to be calibrate.
See “Touchscreen calibration” on page 189

Error message when USB 
has been disconnected

- The USB disconnection has not been done 
properly (see “USB memory stick disconnec-
tion” on page 108)
- The data transfer was not completed when 
USB key was disconnected.

No beep is emitted when 
the USB memory stick is 
connected

- A previous USB memory stick has not been 
properly disconnected (see “USB memory 
stick disconnection” on page 108).
- The USB memory stick is not detected by 
the 2000 Platform: use another memory stick, 
or another storage media; or transfer data via 
USB cable (see “Transferring files to a PC 
with the USB cable” on page 95).

Error message when 
upgrade via Ethernet is 
confirmed

- Check the Server Name is correctly entered 
(see “Installation from another server” on 
page 175)

Error message when 
upgrade via USB key is 
confirmed

Check the USB key is correctly connected 
(see “USB memory stick connection” on 
page 108)

Error message when 
unlocking the instrument

- The password is not the correct one (see 
“Locking the 2000 Platform” on page 183).

Troubleshooting Solution
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Formatting the USB memory stick onto the 
2000 Platform

If the USB icon  is displayed on the upper banner of the screen, when 
a USB memory stick is connected to the 2000 Platform, this may means the 
memory stick must be formatted.

If the stick needs to be formatted, proceed as follows:

1 Insert the memory stick into one of the USB port on the top of the 
2000 Platform.

2 Press the HOME button

3 Validate the Settings icon to open the System Settings page.

4 On the right menu keys, successively select Expert tools > Media 
utilities > Usbflash Format.

5 Confirm your choice to actually format the USB memory stick.

Erase disk
To delete all the disk contents of the 2000 Platform:

1 On the Home page, Press twice the Settings icon to open the 
System Settings page

2 Press Expert Tools >  Media Utilities, 

3 Select Erase Disk to delete all the disk contents into the 2000 Plat-
form.

A confirmation must be validated before the deletion.

As for any media formatting, please note that all data 
present on the USB memory stick will be irremediably 
lost.
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Touchscreen calibration
If you meet problems when using the touchscreen (example: pressing on 
an icon does not work correctly...) a calibration can be performed on the 
2000 Platform touchscreen.

To calibrate the touchscreen, proceed as follows:

1 Push the HOME button

2 Press twice the Settings icon to open the System Settings page.

3 Press Expert Tools menu key

4 Press Touchscreen Calibration key

A blue slightly smaller screen appears, displaying a little target on the 
left hand corner. 

5 Click on this target (preferably with the touchscreen pen). 

6 A new target appears then and again, for a total of 4 times, in order to 
click on all corners of the screen.

If all the targets are not correctly touched, the touchscreen cannot be used. 
Otherwise, the touchscreen may be used directly.

Figure 100 Touchscreen calibration

Target



Chapter 16 Maintenance and Troubleshooting
Troubleshooting

190 User Manual 79000000203 Rev. 005

Changing the battery
If you meet problems during the Platform functioning, or if the battery does 
not charge anymore when plugged, this may require the battery to be 
replaced.

Accessing to the damaged battery

To access the battery of the 2000 Platform, proceed as follows:

1 Switch off the instrument and disconnect the mains supply.

2 Turn the instrument face down on the work surface.

3 If any, remove the module installed (see “Removing a module” on 
page 15).

4 Remove the battery door

5 Pull the battery connector from its housing, to disconnect it from the 
base, taking care not to damage the connector into which it is 
plugged.

CAUTION

Battery is not interchangeable in the field. It must be 
replaced exclusively for maintenance purpose.

Figure 101 Battery installation

 Battery 
door

Battery
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Installing a new battery
1 Set the battery into the Platform

2 Connect the new battery in the connector of the 2000 Platform, in the 
right way using the location notch.

Contact Viavi local Sales Service to get a new battery.

Date and Time parameters will be lost when battery is 
disconnected.

Figure 102 Setting a new battery

When putting a battery back into its seating, make sure 
that its connector engages correctly with the one of the 
base and that the door is correctly closed.
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Launching the «Autotune» process (for 
capacitive touchscreen)

In case of problem with the capacitive touchscreen of your SmartOTDR, an 
«Autotune» can be performed:

1 From the Home page, press Settings icon top open the System 
Settings key

or 

If the use of the touchscreen is not possible, press simul-
taneously the up and down arrow keys on the Platform to 
open the System Settings screen.

2 Press again the up and down arrow keys simultaneously.

A dialog box displays, asking if you wish to perform an Autotune.

3 Press Confirm to start Autotune process.

NOTEDo not use any battery other than the one 
supplied with the instrument, or supplied by Viavi.

Figure 103 Autotune process
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A dialog box displays during the 
process.

Once the dialog box is closed, the Autotune process is completed, 
and the screen is calibrated.

General information on warranty
The warranties described herein shall apply to all commercially available 
Viavi products. Any additional or different warranties shall apply only if 
agreed to by Viavi in writing. These warranties are not transferable without 
the express written consent of Viavi. 

Hardware Warranty
Viavi warrants that Hardware Product sold to customer shall, under normal 
use and service, be free from defects in materials and workmanship. Infor-
mation regarding the specific warranty period for this product can be 
obtained by contacting your local Viavi Customer Service Representative, 
or at our web site www.viavisolutions.com. If installation services have 
been ordered, the warranty period shall begin on the earlier of (1) comple-
tion of installation, or (2) thirty (30) days after shipment to customer. If 
Installation Services have not been ordered, the warranty period shall 
begin upon shipment to Customer. Hereafter these periods of time shall be 
collectively referred to as the Initial Warranty Period.

Viavi ’s obligation and customer’s sole remedy under this Hardware 
Warranty is limited to the repair or replacement, at Acterna’s option, of the 
defective product. Viavi shall have no obligation to remedy any such defect 
if it can be shown: (a) that the Product was altered, repaired, or reworked 
by any party other than Viavi without Viavi’s written consent; (b) that such 

CAUTION

 Do not touch the product during the Autotune process!
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defects were the result of customer’s improper storage, mishandling, 
abuse, or misuse of Product; (c) that such defects were the result of 
customer’s use of Product in conjunction with equipment electronically or 
mechanically incompatible or of an inferior quality; or (d) that the defect was 
the result of damage by fire, explosion, power failure, or any act of nature.

Viavi performed repairs shall be warranted from defective material and 
workmanship for a period of ninety (90) days, or until the end of the Initial 
Warranty Period, whichever is longer. Risk of loss or damage to Product 
returned to Viavi for repair or replacement shall be borne by customer until 
delivery to Viavi.

Upon delivery of such product, Viavi shall assume the risk of loss or 
damage until that time that the product being repaired or replaced is 
returned and delivered to customer. Customer shall pay all transportation 
costs for equipment or software shipped to Viavi for repair or replacement. 
Viavi shall pay all transportation costs associated with returning repaired or 
replaced product to customer.

Warranty disclaimer
For hardware and/or services furnished by Viavi, the foregoing warranties 
are in lieu of all other warrantees and conditions, express or implied. Viavi 
specifically disclaims all other warranties, either express or implied, on any 
hardware, documentation or services including but not limited to warranties 
relating to quality, performance, noninfringement, merchantability or fitness 
for a particular purpose, as well as those arising from any course of dealing, 
usage or trade practice. under no circumstances will Viavi be liable for any 
indirect or consequential damages related to breach of this warranty.
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